Final Report

SAFETY CONSCIOUS PLANNING IN INDIANA: PREDICTING SAFETY BENEFITS IN CORRIDOR STUDIES

VOLUME 2
PASS AND INPASS USER MANUAL

Andrew P. Tarko
Michal Inerowicz
Hong Liang

May 2007
Final Report

FHWA/IN/JTRP-2006/21

Safety Conscious Planning in Indiana: Predicting Safety Benefits in Corridor Studies

Volume 2
PASS and INPASS User Manual

By

Andrew P. Tarko
Professor of Civil Engineering

Michal Inerowicz
Graduate Research Assistant

Hong Liang
Graduate Research Assistant

Jorge Ramos
Postdoctoral Research Associate

School of Civil Engineering
Purdue University

Joint Transportation Research Program
Project No. C-36-59LL
File No. 8-5-38
SPR-2875

Conducted in Cooperation with the
Indiana Department of Transportation and the
U.S. Department of Transportation
Federal Highway Administration

The contents of this report reflect the views of the authors, who are responsible for the facts and the accuracy of the data presented herein. The contents do not necessarily reflect the official views or policies of the Indiana Department of Transportation or the Federal Highway Administration at the time of publication. The report does not constitute a standard, specification, or regulation.

Purdue University
June 2007
Table of Contents

1 Introduction ................................................................................................................ . 3
2 Software Installation ................................................................................................... 5
  2.1 INPASS installation ............................................................................................ 5
  2.2 PASS installation .............................................................................................. 10
3 PASS and INPASS in Transportation Safety Planning ............................................ 17
  3.1 Calibration......................................................................................................... 17
  3.2 Prediction .......................................................................................................... 23
4 Expanded Segment Table ......................................................................................... 26
5 Intersection Table..................................................................................................... 29
6 Importing Crash Data .............................................................................................. 35
7 Assigning Crashes to Roads .................................................................................... 38
8 Predicting Crash Frequencies .................................................................................. 43
9 Editing Models and Default Values ........................................................................ 48
  9.1 Modifying Segment Crash Prediction Models .................................................. 49
  9.2 Modifying Intersection Crash Prediction Models ............................................. 53
  9.3 Entering New Models ....................................................................................... 53
10 Calibration Factors ................................................................................................. 57
11 Software Demonstration - A Corridor Study ........................................................ 64
  11.1 PART I Predicting Crash Frequencies ............................................................ 67
  11.2 PART II Calibration of Crash Prediction Equations ........................................ 90
  11.3 PART III Assigning Crashes to Roads ............................................................ 103
1 Introduction

This manual is an instructional and support material for PASS (Planning Analysis Software for Safety) and INPASS (INput to Planning Analysis Software for Safety) tools. This manual includes detailed information on how the PASS and INPASS tools work, what features are available, what the required input format is and what output is generated by the tools. The manual has been arranged in an order which follows the transportation planning process.

The PASS tool was developed as an add-in to TransCAD, which is a Geographic Information System (GIS) software package designed for transportation professionals by Caliper Corporation. The PASS tool is used to predict safety in alternative transportation networks (Figure 1-1). This add-in has been developed as a universal tool to serve needs of any agency equipped with the geometric characteristics of its present or planned network. PASS tool is capable of predicting annual crash frequencies with calibration of the predictive equations if needed. The PASS equation editor allows the user to modify default input values, update the existing and enter new predictive equations. The PASS tool predicts annual crash frequencies for alternative future networks to allow their comparison from the safety point of view. Features of the PASS tool can be used independently from each other and in an order determined by the purpose. Specifics concerning the structure of the PASS, default values, input and output file formats are presented in the following chapters.

The INPASS tool has been developed specifically for Indiana as an add-in to the TransCAD Geographic Information System package (Figure 1-2). INPASS converts Highway Performance Monitoring System (HPMS) and other data to the input required by the PASS tool. The INPASS tool is capable of extracting intersection characteristics from segment data. INPASS is also capable of assigning reported crashes to road segments and intersections. The crash counts are an input to the PASS calibration module that allows more accurate prediction of future crashes.
Each module of the INPASS tool can be independently executed according to the user needs. INPASS tool provides one or multiple outputs, depending on the number of steps executed in the tool. All tables are saved as database files (.DBF) and they can be easily converted to geographic files that allow the user to display the results on a map.

**Notes**

- In this text nodes are map representation entities used in TransCAD to represent segments in the network. Intersections are user-defined entities consisting of at least three segments. Intersections generated by the INPASS tool are state-state intersections.

- PASS and INPASS features and TransCAD instructions requiring any option selection or button pressing are **bolded**. Names of files and PASS and INPASS modules names are also **bolded**. All entries from the user’s side requiring typing in input are given in *italic*. 
2 Software Installation

2.1 INPASS installation

The INPASS tool was developed as an add-in to TransCAD Geographic Information System (GIS) software package. INPASS tool has been written in the Geographic Information System Developer’s Kit (GISDK) programming language which communicates with TransCAD programs and facilitate exchange of data and results.

Prior to installing the INPASS tool, place the INPASS.rsc resource file in an easily traceable folder on your computer hard drive. This can be done by copying and pasting the provided file to the desired location. The INPASS.rsc resource file contains the INPASS source code. Once the INPASS.rsc resource file is in the desired folder you can began to install the INPASS software. Execute the following steps to install the software.

1. Run TransCAD
2. Select [Tools ➔ Add-Ins…]. This will display the Add-ins dialog box.
3. Select the GIS Developer’s Kit and press OK to display the GISDK Toolbox (Figure 2-1).
4. Press the Compile to UI button (Figure 2-2). This will bring up the Compile window (Figure 2-3). Utilizing the Look in: dropdown menu, find the folder with the resource file INPASS.rsc. Click on the INPASS.rsc file. The name INPASS.rsc will appear in the File name entry of the Compile dialog box. Click Open. Pressing this button will display the Save As Toolbox.
Figure 2-1 Add-ins dialog box

Figure 2-2 GISDK Toolbox

Figure 2-3 Compile window
In the Save As toolbox (Figure 2-4), drop down the Look in: menu (top of the Save As window) and select the folder with the INPASS.rsc resource file. Type in INPASS in the File name: entry field and press Save.

This operation will generate seven files for the INPASS add-in (Figure 2-5). Check if you have the following files (inpass.1, inpass.2, inpass.3, inpass.4, inpass.5, inpass.6 and inpass.dbd) stored in the same folder where the INPASS.rsc resource file has been placed.
Close the GISDK Toolbox and go back to [Tools ➔ Add-Ins…]. Add-ins dialog box will appear (Figure 2-6). Press the Setup button. Pressing this button will display the Setup Add-ins dialog box (Figure 2-7).
5. Inside the **Setup Add-ins** dialog box press the **Add** button and enter the following settings:

- **Type**: *Macro*
- **Description**: *INPASS*
- **Name**: *INPASS*

UI Database: Browse for the **inpass.dbd** resource file (which is stored in the same folder where the INPASS.rsc resource file is placed) by clicking the **Browse** button and selecting it. Press the **Open** button in the **Locate UI Database** toolbox (Figure 2-8). The UI database entry in the **Setup Add-ins** dialog box should be filled with the path to the folder with the inpass.dbd and INPASS.rsc files.

![Locate UI Database](image)

*Figure 2-8 Locate UI Database*

Inside the Setup Add-ins dialog box press the **OK** button (Figure 2-9). The INPASS tool has been installed. To run the software press the **OK** button again.
6. To run the INPASS software at any time from TransCAD main environment go to [Tools ➔ Add-Ins… ➔ INPASS] and press the OK button.

![Setup Add-ins dialog box](image)

Figure 2-9 Setup Add-ins dialog box

### 2.2 PASS installation

The PASS tool was developed as an add-in to TransCAD Geographic Information System (GIS) software package. PASS tool has been written in the Geographic Information System Developer’s Kit (GISDK) programming language which communicates with TransCAD programs and facilitate exchange of data and results.

Prior to installing the PASS tool, place the PASS.rsc resource file in an easily traceable folder on your computer hard drive. This can be done by copying and pasting the provided file to the desired location. The PASS.rsc resource file contains the PASS source code. Once the PASS.rsc resource file is in the desired folder you can began to install the PASS software. Execute the following steps to install the software.
1. Run TransCAD

2. Select [Tools ➔ Add-Ins…]. This will display the Add-ins dialog box (Figure 2-10).

![Figure 2-10 Add-ins window](image)

3. Select the GIS Developer’s Kit and press **OK** to display the GISDK Toolbox.

4. Press the Compile to UI button (Figure 2-11). This will bring up the Compile window (Figure 2-12). Utilizing the Look in: dropdown menu, find the folder with the resource file PASS.rsc. Click on the PASS.rsc file. The name PASS.rsc will appear in the File name: entry of the Compile dialog box. Click Open. Pressing this button will display the Save As Toolbox.

![Figure 2-11 GISDK Toolbox](image)
In the Save As toolbox (Figure 2-13), drop down the Look in: menu (top of the Save As window) and select the folder with the PASS.rsc resource file. Type in PASS in the File name: entry field and press Save.

This operation will generate seven files for the PASS add-in. Check if you have the following files (pass.1, pass.2, pass.3, pass.4, pass.5, pass.6 and pass.dbd) stored in the same folder where the PASS.rsc resource file has been placed (Figure 2-14).
Figure 2-13 Save As window

Figure 2-14 Generated PASS files
Close the GISDK Toolbox and go back to [Tools ➤ Add-Ins…]. Add-ins dialog box will appear (Figure 2-15). Press the Setup button. Pressing this button will display the Setup Add-ins dialog box (Figure 2-16).

5. Inside the **Setup Add-ins** dialog box press the **Add** button and enter the following settings:
   - Type: *Macro*
   - Description: *PASS*
- Name: PASS
- UI Database: Browse for the `pass.dbd` resource file (which is stored in the same folder where the PASS.rsc resource file is located) by clicking the **Browse** button and selecting it. Press the **Open** button in the Locate UI Database toolbox (Figure 2-17).

The UI database entry in the **Setup Add-ins** dialog box should be filled with the path to a folder where the pass.dbd and PASS.rsc files are located.

![Locate UI Database](image)

**Figure 2-17 Locate UI Database**

Inside the Setup Add-ins dialog box press the OK button and the PASS software has been installed on your computer (Figure 2-18). To run the software, press the OK button again.
6. To run the PASS software at any time from TransCAD main environment go to [Tools ➔ Add-Ins… ➔ PASS] and press the OK button.
3 PASS and INPASS in Transportation Safety Planning

INPASS and PASS facilitate safety consideration in the Indiana planning of transportation networks (Figure 3-1). INPASS is a preprocessing tool to convert Indiana data into an input required by PASS. PASS is used to update and calibrate crash prediction models and to predict annual crash frequencies in alternative transportation networks. The full transportation safety planning process involves calibration phase were updated/modified crash prediction models are calibrated for recent crash data and the existing transportation network (Figure 3-2). Once the calibration phase is finished, the user can predict future transportation safety in alternative future networks by pre-processing the prediction input data and then calculating future crash frequencies by applying the crash prediction models supplemented with the calibration factors.

3.1 Calibration

The calibration phase is not always necessary. If the crash prediction equations do not require calibration or the calibration factors obtained last time are still applicable, then this phase can be skipped.

Pre-processing calibration input data with INPASS

The input data and the results are stored in two main tables: segment tables and intersections tables. These tables are being modified with INPASS and PASS in a sequence of steps. The calibration process utilizes the current road network and recent crashes recorded in this network to generate a set of calibration factors that reconcile to the maximum possible extent the calculated and recorded crash counts. Pre-processing the calibration input data is required to convert the currently existing network and crash data into the format that is suitable for PASS.
Figure 3-1 Safety consideration in transportation planning
Pre-processing calibration input data involves five steps:

1. Expanding the initial segment table so it contains all the necessary variables used in the crash prediction models for segments (see Section 4, page 26). This table should reflect the road network during the period for which the crash data are available.

2. Creating an intersection table with all variables used in the crash prediction models for intersections (see Section 5, page 29).

3. Calculating crash predictions (see Section 8, page 43).

4. Reading and reformatting the original crash data into 15 crash tables (see Section 6, page 35).

5. Assigning crashes to the segments and intersections where they occurred (see Section 7, page 38). Only the table (called **Type10**) including data found in the crash database record type 10 is used.
The outcome from these five steps includes the expanded segment table with assigned crashes and the intersection table with assigned crashes.

**Important note**

The currently available information about traffic control at the ends of road segments is used by INPASS to deduce the traffic control at intersections in the generated intersection table. It was found out that missing data cause frequent misclassification in two-way stop-controlled intersections. A separate table with intersections ID and correct type of control has been created. This table has to be used to correct the type of control in the intersection table. In the future, when the traffic control data are improved, this additional step can be eliminated. It is also expected, that an intersection database will be created and maintained in the future. That anticipated database might eliminate the need for creating an intersection table with INPASS.

**Updating crash prediction models with PASS**

Crash prediction is facilitated with two groups of crash prediction models: for segments and for intersections (Figure 3-3). Road segments are divided into types such as: rural two-lane roads, urban multilane roads, rural interstate roads, etc. Also intersections are divided into several types such as: signalized intersections, signalized interchanges, all-way stop-controlled intersections, etc. Each segment and intersection type may have up to three corresponding crash prediction models that calculate the average annual number of PDO, Injury/Fatal, and all crashes. These calculations are based on road traffic and geometry characteristics.

The PASS tool includes a convenient editor of crash prediction models. It allows changing the input default values, changing parameter values of the existing models, adding and removing model variables, removing the existing models, and adding new models (see Section 9, page 48).
Figure 3-3 Modifying crash prediction models
Figure 3-4 Calibrating crash prediction models
The standard calibration generates a calibration factor for each crash prediction model to match the calculated number of crashes with the reported number of crashes. These calibration factors are saved in dedicated files for future use in the crash prediction step. The user has also an option of defining parts of the road network that should have additional factors representing these parts. In a corridor study or other planning study focused on a part of the network, that part should have its own calibration factor to improve crash prediction there. Other example justification might be a region with considerably different topography than the rest of the network area (southern Indiana) or the area with considerably different driver population or land development (Indianapolis). The calibration process will generate additional user-defined calibration factors and store them in the same files with the standard calibration factors. For details refer to Section 10 on page 57.

### 3.2 Prediction

The PASS tool predicts annual crash frequencies with the crash prediction models based on the future traffic volumes, network characteristics, and roadway characteristics (see Section 8, page 43). A planner can run the tool multiple times for various planning alternatives. The outcome is in the form of the input segment and intersection tables supplemented with the future annual number of crashes. The user can easily aggregate the obtained crashes by severity and then convert to costs by applying average crash costs.

**Pre-Processing prediction input data with INPASS**

As the calibration phase, the crash prediction phase may also require pre-processing the calibration input data. If the alternative future road networks are represented with segment tables that follow the format suitable for INPASS, then the INPASS tool will expand them and will create an intersection table. In this case, the pre-processing phase involves two steps:
1. Expanding the initial segment tables for planning alternatives to add the variables needed in crash prediction. These tables should reflect the future road networks with future traffic volumes obtained with the Indiana Travel Demand Model (see Section 4, page 26).

2. Creating an intersection table with the variables used in the crash prediction models for intersections (see Section 5, page 29).

The outcome from these two steps includes an expanded segment table and an intersection table for each planning alternative.

Another viable alternative of obtaining input tables for crash prediction is altering the segment and intersection tables generated for the existing road network. There are two major differences between existing and future road networks:

1. A future network differs from an existing network by traffic volumes. These future traffic volumes are obtained with the Indiana Travel Demand Model or other planning models for road networks. TransCAD allows easy and fast updating/adding columns with traffic volumes.

2. The future road networks are different from the existing networks by a limited number of segments and intersections. These upgraded or new road facilities typically follow design standard thus their basic roadway characteristics are known. TransCAD allows editing, adding, and removing records in segment and intersection tables.

If the prediction involves user-defined calibration factors (see Section 10, page 57), each such factor requires adding a column in the segment and intersection tables which contains information if a given segment or intersection belongs to the corresponding part of the network.

**Predicting crash frequencies in future networks with PASS**

Having future network representation available in the form of segment and intersection tables, the user can predict crash frequencies for a number of alternatives (Figure 3-5) by applying the updated crash prediction models and the calibration factors stored in the calibration factors file (see Section 8, page 43).
Figure 3-5 Predicting crash frequencies in future networks
4 Expanded Segment Table

The crash prediction models include a number of traffic and roadway characteristics that have to be known to calculate the annual crash frequency. Most of these characteristics are available in the road inventory and HERS HPMS databases and they have been compiled in an initial segment table.

PASS requires an input table that includes these characteristics written in a proper format. If some variable in the initial segment table is in incorrect format, it has to be converted to the desired format and stored in a new column added to the initial segment table. This conversion and expansion process is facilitated with INPASS. The original and new variables and required conversions are presented in Appendix A.

Prior to running INPASS Expand Segment Table feature, open all desired input network segment tables (present or future) within the TransCAD environment. This will allow INPASS to perform its operations on the opened views and create the desired output (expanded segment network table). To obtain an expanded segment table for present network or any of the planned alternatives, press the Expand Segment Table option within the INPASS main interface as shown in Figure 4-1.

![Figure 4-1 INPASS interface window](image-url)
The Expand Segments Table option will bring up Expand Segments window (Figure 4-2) which should be filled with appropriate input segment network table (Input Segment table) which we want to expand and location where the output file (save table to). Pressing the Expand button will create expanded segment network table. Expand option should be executed once for present segment network table and once for each of the planned alternative segments network tables. Each time when the user presses Expand option he will need to re-run Expand Segments Table option to return to the Expand Segments window and re-run the Expand option for other alternatives.

![Figure 4-2 Expand Segments window](image)

### Table 4-1 Variables used in the models

<table>
<thead>
<tr>
<th>Variable/Characteristic</th>
<th>Column Name</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annual average daily traffic</td>
<td>H33AADT</td>
<td>Unit: vehicles/day</td>
</tr>
<tr>
<td>Length of section</td>
<td>LENGTH</td>
<td>Unit: mile</td>
</tr>
<tr>
<td>Lane width</td>
<td>H54LANEW</td>
<td>Unit: foot</td>
</tr>
<tr>
<td>Shoulder width</td>
<td>H59RSHLDW</td>
<td>Unit: foot</td>
</tr>
<tr>
<td>Inside shoulder width</td>
<td>H60LSHLDW</td>
<td>Unit: foot</td>
</tr>
<tr>
<td>Median width</td>
<td>H56MEDW</td>
<td>Unit: foot</td>
</tr>
<tr>
<td>Access control</td>
<td>H55ACCESS</td>
<td>Level: 1, 2, 3</td>
</tr>
<tr>
<td>Signal intersection presence</td>
<td>H92NSIG</td>
<td>Binary: 0, 1</td>
</tr>
<tr>
<td>Average degree of horizontal curve</td>
<td>ADCURVE</td>
<td>Unit: english</td>
</tr>
<tr>
<td>Average grade on section</td>
<td>AGRADE</td>
<td>Unit: percent</td>
</tr>
<tr>
<td>Curb presence</td>
<td>CRB</td>
<td>Binary: 0, 1</td>
</tr>
<tr>
<td>Functional class</td>
<td>FC</td>
<td>Binary: 0, 1</td>
</tr>
<tr>
<td>Improved shoulder presence</td>
<td>ST_IMPROVE</td>
<td>Binary: 0, 1</td>
</tr>
<tr>
<td>Intersection with left turn bay and no right turn bay</td>
<td>INT_L</td>
<td>Binary: 0, 1</td>
</tr>
<tr>
<td>Continuous left turn lane</td>
<td>CELT</td>
<td>Binary: 0, 1</td>
</tr>
</tbody>
</table>
The expanded segment table is saved as a database file (.DBF) within the TransCAD environment. If the user wishes to save the file in any other format, the output DBF file can be re-saved with the desired extension using the TransCAD standard features by pressing File ➔ Save As and specifying the desired extension.

Table 4-1 provides the list of model variables and names of columns in the expanded segment table. A complete description of model variables can be found in Appendix B.
5 Intersection Table

To predict annual numbers of crashes at intersections, an intersection table with intersection characteristics is needed. Such an initial data table can be generated from the segment network table (HPMS). The original HPMS segment network table developed in TransCAD as a geographic file has two layers associated with it: the segment layer and the node layer, which contained only the geographic location and the node ID. Nodes in the node layer are composed of actual state-state road intersections, and dummy nodes are used to code inventory segments for the segment layer. To create the actual intersection table only state-state road intersection nodes were chosen and all dummy nodes were removed. The following figure (Figure 5-1) shows all nodes (left) and state-state road intersections only (right) in Indiana.

![Figure 5-1 Comparison of segments inventory node layer (left) and extracted actual state-state intersections (right) in Indiana](image)
User can generate state-local intersection nodes by adding desired local streets to the original HPMS segment network table with their characteristics. In order for the **Create Intersection Table** option to generate correct node characteristics from the segment network table make sure all variables necessary for linking between segment network table and generated intersection network table (Table 4-1) are entered. If a value of a variable in the segment network table which is used for linking with the generated intersection table is not known or the value is missing created characteristic in the generated intersection table will contain incorrect value.

*Generating an intersection table with INPASS*

Prior to running the Create Intersections Table option, make sure the input segment network tables (present or any of the planned alternatives) and their corresponding node view tables, from which the intersection tables are generated, are open. The opened input segment network table (present or any of the planned alternatives) should contain the node information. This information is hidden in the default view and can be added within the TransCAD environment by selecting Dataview → Formula Fields… → Node Fields…, highlighting ID, checking Both option, and clicking the OK button as shown below in Figure 5-2.

![Node Formula Fields interface window](image)

*Figure 5-2 Node Formula Fields interface window*
To generate an intersection table, select the Create Intersections Table option inside the main menu of INPASS tool (Figure 5-3) and then select the Create button in the Create Intersections window (Figure 5-4).

![INPASS main menu](image)

Figure 5-3 INPASS main menu

![Create Intersections window](image)

Figure 5-4 Create Intersections window

Intersection table should be generated for present network and each of the planned alternatives. Only one table can be created at a time. To create an intersection table for each planned alternative, user should re-run the Create option inside the Create Intersections window. Each time when the user presses Create option he will need to re-run Create Intersection Table option to return to the Create Intersections window and re-run the Create option for other alternatives.
Structure of generated intersection table

The generated intersection network table contains 17 columns and has been saved as a geographic file within the TransCAD environment. The first column is the ID of the node carried over from the network segment table. Keeping the original node ID allows the user to link the two network tables (segments and generated intersections) with each other using TransCAD standard features. Columns 2 through 10 contain variables used in crash prediction extracted from the segment table based on conditions as shown in. Columns 11 through 16 contain county and route numbers for all links connecting to a particular intersection.

Attaching correct intersection classification in current network

The HERS HPMS initial segment table uses the same code for two distinct cases: (1) Missing control information, and (2) No control at the end node of the segment. This poses a problem when a type of control at intersections is derived from control information included in the table and may lead to incorrect classification of intersection types when using the Create Intersection Table module. This problem will not occur once the initial segment table has complete control data. To obtain accurate classification without waiting for fixing the initial segment table, a patch has been created. State-state intersections where checked using video-log and correct intersection classification was developed. Correct intersection classification is saved as a DBF file which contains TransCAD ID of the intersection and facility type information (INT_TYPE_F). Correct intersection classification file should be appended to intersection table prior to running the Calculate Crashes Option and also prior to running Assign Crashes Option. To append correct intersection classification file to the created intersection table do the following.

1. Open the created intersection table and correct intersection classification table in TransCAD environment.
2. Select the Dataview toolbar option.
3. Select the Join... feature inside the Dataview option.
Table 5-1 Relation between expanded segment table and intersection table.

<table>
<thead>
<tr>
<th>Intersection Table Column</th>
<th>Corresponding column(s) in segment table with comments on applied operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>ID. Values taken directly from the HERS HPMS segment table.</td>
</tr>
<tr>
<td>H1AADT</td>
<td>H33AADT. Summation of volumes on major approaches.</td>
</tr>
<tr>
<td>H2AADT</td>
<td>H33AADT. Summation of volumes on minor approaches.</td>
</tr>
<tr>
<td>H3URBRUR</td>
<td>Item 13. If $\sum$(Item 13)$\geq$2 then H3URBRUR=1 otherwise H3URBRUR=1. Summation performed on all links.</td>
</tr>
<tr>
<td>H4SHOULD</td>
<td>Item 59. If $\sum$(Item58)$=2$ or $\sum$(Item58)$=4$ place then H4SHOULD=1 otherwise H4SHOULD=0. Summation performed for major approaches.</td>
</tr>
<tr>
<td>H5RTMAJ</td>
<td>Item 89. If Item89$\geq$1 and Item89$\leq$3 for any major link then H5RTMAJ=1 otherwise H5RTMAJ=0</td>
</tr>
<tr>
<td>H6LTMAJ</td>
<td>Item 88. If Item88$\geq$1 and Item88$\leq$3 for any major link then H6LTMAJ=1 otherwise H6LTMAJ=0</td>
</tr>
<tr>
<td>H7LANE</td>
<td>$\sum$(Item34)/2+$\sum$n, where n is determined in A. Conditions for n checked separately for each link and total value for n is obtained.</td>
</tr>
<tr>
<td>H8PKTRUCK</td>
<td>Item 83. $\sum$(Item83(i)*Item33(i))/$\sum$(Item33(i)) for i=1..n, where n is the number of links connecting to particular node. Operation performed on all links.</td>
</tr>
<tr>
<td>H9MEDWDTH1</td>
<td>Item 57. $\sum$(Item57)/2. This operation is performed on major links.</td>
</tr>
<tr>
<td>H10MEDTYPE</td>
<td>Item 56. If Item 56$&lt;4$ for either or both major links then H10MEDTYPE =1 otherwise H10MEDTYPE=0.</td>
</tr>
<tr>
<td>H11RSIG$^1$</td>
<td>Based on INT_TYPE_F classification. If INT_TYPE_F=8 then H11RSIG =1, otherwise 0.</td>
</tr>
<tr>
<td>H12LEG3$^1$</td>
<td>Based on INT_TYPE_F classification and number of links. If INT_TYPE_F $\geq$ 1 and INT_TYPE_F $\leq$ 4 and H14LINK= null then H12LEG3 =1, otherwise 0.</td>
</tr>
<tr>
<td>H11LINK</td>
<td>Item 10. Values taken directly from the HERS HPMS segment table.</td>
</tr>
<tr>
<td>H12LINK</td>
<td>Item 10. Values taken directly from the HERS HPMS segment table.</td>
</tr>
<tr>
<td>H13LINK</td>
<td>Item 10. Values taken directly from the HERS HPMS segment table.</td>
</tr>
<tr>
<td>H14LINK</td>
<td>Item 10. Values taken directly from the HERS HPMS segment table.</td>
</tr>
<tr>
<td>H15LINK</td>
<td>Item 10. Values taken directly from the HERS HPMS segment table.</td>
</tr>
<tr>
<td>H16LINK</td>
<td>Item 10. Values taken directly from the HERS HPMS segment table.</td>
</tr>
<tr>
<td>INT_TYPE_F$^2$</td>
<td>Correct intersection classification for Indiana. Should be appended to created intersection table (output of Create Intersection Table module) prior to crash prediction and crash assignment.</td>
</tr>
</tbody>
</table>

1. Value for this variable is determined based on columns in the intersection table
2. Column appended to intersection table
<table>
<thead>
<tr>
<th>Variable/Characteristic</th>
<th>Column Name</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major road approach volume</td>
<td>H1AADT</td>
<td>Unit: vehicles/day</td>
</tr>
<tr>
<td>Minor road approach volume</td>
<td>H2AADT</td>
<td>Unit: vehicles/day</td>
</tr>
<tr>
<td>Surrounding land use</td>
<td>H3URBRUR</td>
<td>Binary: 0, 1</td>
</tr>
<tr>
<td>Paved shoulder</td>
<td>H4SHOULD</td>
<td>Binary: 0, 1</td>
</tr>
<tr>
<td>Right-turn lane on major road</td>
<td>H5RTMAJ</td>
<td>Binary: 0, 1</td>
</tr>
<tr>
<td>Left-turn lane on major road</td>
<td>H6LTMAJ</td>
<td>Binary: 0, 1</td>
</tr>
<tr>
<td>Number of lanes</td>
<td>H7LANE</td>
<td>Count</td>
</tr>
<tr>
<td>Three leg intersection</td>
<td>H11LEG3</td>
<td>Binary: 0, 1</td>
</tr>
<tr>
<td>Median width</td>
<td>H9MEDWDTH1</td>
<td>Unit: foot</td>
</tr>
<tr>
<td>Ramp with signal</td>
<td>RSIG</td>
<td>Binary: 0, 1</td>
</tr>
</tbody>
</table>

4. In the Settings tab specify: Joining from: Table: Intersection table, Field: ID to: Table: C_INT_CLASS, Field: ID.

5. Correct intersection classification (INT_TYPE_F) will be appended to the specified Intersection table.

**Important Note** If control type information for links in the initial input segment table is complete and correct then the Create Intersection Table feature will provide correct classification.
6 Importing Crash Data

Crash data collected by law enforcement agencies across Indiana are saved in numerical format, which is incompatible with the TransCAD environment. INPASS can read the source crash data files and convert them to the format compatible with the TransCAD environment. INPASS separates the source file into 15 tables corresponding to 15 types of crash records in the source file:

1. Collision (Record Type = 10)
2. Property Damage (Record Type = 11)
3. Unit (Record Type = 20)
4. Damage (Record Type = 21)
5. Factors (Record Type = 22)
6. Trailer (Record Type = 23)
7. Commercial Unit (Record Type = 24)
8. Individual (Record Type = 30)
9. Operator Injured Individual (Record Type = 31)
10. Restriction (Record Type = 32)
11. Citation (Record Type = 33)
12. Non Motorist (Record Type = 34)
13. Test Type (Record Type = 35)
14. Apparent Physical Condition (Record Type = 36)
15. Citation Type (Record Type = 37)

Crash **Type10** table stores collision records that are used to assign reported crashes to the segments and intersections where these crashes occurred.

*Reading crash data with INPASS*

To extract crash table Type10 and other tables from the source crash file, select the Read Crash Data option in the INPASS main menu (Figure 6-1).
Selecting this option displays the Reading Crashes Data interface window (Figure 6-2). The user has to specify the folder where the original crash data is stored (Folder to find input file) and the folder where the 15 output tables (Folder to save output data) are to be saved. The output files are saved with a default name specifying the record type and year of the original crash data (ex. type10_2005IF). Year of the original crash data will be displayed in the Read Crashes Data window once the user specifies where the input file is located. This helps avoid reading in the same year multiple times.

After specifying the required input, the user should press the Read button. If the user wishes to check if the Read Crash Data module is running, he can view the folder where the files are being saved. The indicated file size should increase each time the user refreshes the widow display. INPASS adds two empty columns (OSEFC and F_CDIST).
to the **Type10** table for storing intermediate values generated during crash assignment (see Section 6, page 35).

**Important notes**

1. Before using the **Read Crashes** module, make sure that that the folder to save output data is empty. When TransCAD finds an existing file with the same name, it does not replace it but tries to update it. This can cause INPASS to malfunction.

2. Do not open the generated text files to convert them to geographical files. The resulting geographic files are not editable which may cause the INPASS to malfunction.

**Creating a geographic file**

All generated tables are saved as comma-delimited text files. Only the Crash **Type10** table is also saved as a database file (.DBF) and can be opened with TransCAD without a need of format conversion. Follow three steps to create a geographic file that allows displaying crashes on a map in TransCAD.

1. Open the **TYPE10_DATE.dbf** file in TransCAD

2. Press **YES** when TransCAD asks if the user wants to transform it to a geographic file.

3. Enter the filename but without the dbf extension.
7 Assigning Crashes to Roads

The PASS calibration tool generates calibration factors that adjust the initial predictions to the numbers of reported crashes. Numbers of crashes on road segments and intersections are one of the inputs to the calibration module. To obtain this input, reported crashes recorded by law enforcement agencies across Indiana have to be linked with TransCAD segments and intersections and counted.

**Executing INPASS**

Before running INPASS and the Assign Crashes option, the user must open in the TransCAD environment all the required input files. This can be done by clicking [FILE ➤ OPEN], and specifying the input file location and name. The intersection network input table should be opened as the last one. Make sure that the geographic input files which you open in the TransCAD environment have their dataviews opened. This can be done by opening the file [FILE ➤ OPEN] and pressing the Open Dataview box in TransCAD environment. Prior to running the Assign Crashes option make sure that the correct intersection classification has been appended to the intersection network table (see page 32).

- To assign recorded crashes to segments and intersections where they occurred, select the Assign Crashes option inside the main menu of INPASS (Figure 7-1).
Selecting the Assign Crashes option will display a second interface window (Figure 7-2) where the user will have to specify six inputs:

- **Save table to:** Location where the output tables are to be saved. The Change button allows the user to save output files to a desired location. By default, the output is saved in C:\temp.

- **Input segment table:** Input segment network table (HERS HMPS Input).

- **Input expanded segment table:** Expanded segment network table generated in Expand Segments Table option.

- **Input node table:** Generated intersection table in Create Intersection Table.

- **Input crash table:** Input crash Type10 table generated in Read Crash Data option.

- **Crash Band:** Maximum distance (ft) between the road shoulder and a crash. The crash is not assigned to that segment if the distance is longer. The default value is 32.8 ft.
Once the necessary inputs are entered, selecting the **Assign** button generates two database (.DBF) tables that are saved in the specified directory:

1. The segment network table with appended recorded segment crashes, and
2. The intersection network table with appended recorded intersection crashes.

**Important notes**

The crashes counts are appended at the end of the **Expanded Segments View** (segment network table) and the **Intersections View** (intersection network table) and are saved with the names **ASSIGNEDSEGMENTCRASHES.dbf** and **ASSIGNEDNODECRASHES.dbf**. Before executing the **Assign Crashes** tool, the user should rename the map layer for nodes (intersections) by doing the following.

1. Select the Nodes map,
2. Go to the Menu: **Maps->Layers**,  
3. Press the **Rename** button,
4. Change the name to **NODE_LAYER** or something similar,
5. Select the newly named layer in the **Input Intersections View** dropdown box.

Any name other then the map view will work. The dataview and the map view should have dissimilar names so there is no confusion to the tool when running the **Assign Crashes** option.
Crash assignment algorithm

The Assigning Crashes tool generates 250-foot bands around intersections (type1 through type6, see chapter 5) and 500-foot bands around interchanges (signalized and non signalized, type7 and type 8, see chapter 5) where three or more segments end. Crashes that fall inside these bands are assigned to corresponding intersections and interchanges and are removed from the collection of unassigned crashes. For intersections crash assignment the corrected classification (INT_TYPE_F) appended to the created intersection table is used.

In the next phase, the remaining crashes are being assigned to segments based on the distance between the crash and the closest segment. The maximum distance between the crash and the road outside shoulder (Crash Band) determines if the crash is considered. The crash assignment to segments is done in two steps.

1. For each unassigned crash, INPASS finds the closest segment listed in the expanded segment table and calculates the distance to the segment center. This distance is stored in the Type 10 table column F_CDIST. Also, the half the roadway width measured between the edges of outside shoulders is calculated for this segment and stored in the Type 10 table column OSEFC.

2. The crash is assigned to the closest segment if the distance to the center line (F_CDIST) is at most half the roadway width measured between the edges of outside shoulders (OSEFC) plus the maximum distance between the outside shoulder and the crash (Crash Band). Otherwise, the crash remains unassigned.

Multiple year crash assignment

Single iteration of Assign Crashes option assigns crashes only for one year. To assign crashes reported during several years, the user has to run the Assign Crashes for each year. The ASSIGNEDSEGMENTCRASHES.dbf and ASSIGNEDNODECRASHES.dbf files generated for the first year should be used as an
input file for the second year. The outcome of crash assignment for the second year becomes an input file for the third year, and so on until all years are processed.

Each execution of the Assign crash appends the segment and intersection tables with a set of columns with reported crash counts. The new columns have the header IF_year and PDO_year, where year is extracted automatically from the name of the Type10 crash table (for example, IF_2005 or PDO_2005). If some year is processed twice, then TransCAD adds an numerical index (for example, IF_year1, IF_year2, PDO_year1, PDO_year2).

**Important notes**

1. The output file has to be renamed each time before it can be used as an input file in processing next year. This file renaming operation is required to avoid a mismatch between the files used in the views and the files stored on disk.

2. Make sure that the map for node layer is renamed before each execution. Otherwise, one of the following error messages: **IntCrash not found** or **Bands Layer not found** or **Null value not supported** may appear which indicates that TransCAD gets confused with the intersections geographic file. To fix this problem:
   - Select the Nodes map
   - Go to the Menu: [Maps ➔ Layers].
   - Press the Rename button
   - Change the name to NODE_LAYER or any other name not currently used
   - Select the newly named layer in the Input Intersections View dropdown box.

3. In those cases where the tool stops the execution because of incorrect file names, the temporary views have the prefix tmp and the temporary files have the prefix “~” to help the user identify and delete them before attempting another execution.
8 Predicting Crash Frequencies

An annual crash frequency is the average number of crashes that occur on a segment or at an intersection during one year under given traffic and roadway conditions. The PASS Calculate Crashes tool predicts the annual crash frequencies based on the traffic and road characteristics. Depending on the need, the user has a choice of predicting crash frequencies only for segments, only for intersections, or for both.

PASS calculates crashes with two types of crash prediction models:

\[ A = (K_1 \cdot K_2 \cdot \ldots \cdot K_m) \cdot (k \cdot L \cdot Q^\beta \cdot F_1 \cdot F_2 \cdot \ldots \cdot F_n) \] for segments,

\[ A = (K_1 \cdot K_2 \cdot \ldots \cdot K_m) \cdot (k \cdot Q_1^\beta_1 \cdot Q_2^\beta_2 \cdot F_1 \cdot F_2 \cdot \ldots \cdot F_n) \] for intersections,

where:
- \( A \) = annual crash frequency,
- \( K_j \) = calibration factor for network partition \( j \) (explained in Section 10, page 57),
- \( L \) = length of the segment (miles),
- \( Q \) = segment AADT (veh/day),
- \( Q_1 \) = AADT on the major road of the intersection (veh/day),
- \( Q_2 \) = AADT on the minor road of the intersection (veh/day),
- \( F_i \) = crash modification factor for characteristic \( i \),
- \( F_i = \exp(a_i \cdot (X_i - \overline{X}_i)) \),
- \( a_i \) = coefficient of the variables \( i \),
- \( X_i \) = roadway characteristic \( i \) (for example: lane width, turning bay, etc.),
- \( \overline{X}_i \) = average value of characteristic \( i \),
- \( k, \beta, \beta_1, \beta_2, a_i \) = model parameters.

The user can define a number of various types of segments and intersections. Each type of facility should have corresponding crash prediction models for PDO, Injury/Fatal, and All crashes. The default facility types for segments are as follows:

Type 1: Rural two-lane
Type 2: Rural multilane
Type 3: Urban two-lane
Type 4: Urban multi-lane
Type 5: Rural interstate
Type 6: Urban interstate
Type 7: One way segments

The default facility classifications for intersections are as follows:

- Type 1: Three-Legged stop controlled intersections of two-lane roads
- Type 2: Four-Legged stop controlled intersections of two-lane roads
- Type 3: Three-Legged stop controlled intersections with two lanes on the minor and four lanes on major roads
- Type 4: Four-Legged stop controlled intersections with two lanes on the minor and four lanes on major roads
- Type 5: All-way stop controlled intersection
- Type 6: Signalized intersection
- Type 7: Unsignalized interchange surface area
- Type 8: Signalized interchange surface area

Calibration factors are the result of the calibration procedure and are stored in separate files. The calibration process is explained in Section 10, p. 57. The user has options of calculating crash frequencies with or without calibration factors. The Traffic and road characteristics (variables) required for calculations are stored in two input files: segment network table and intersections network table in the database or geographic file format (.DBF or .DBD). TransCAD allows easy conversion of files in other formats to the required ones by letting the user open the source files in the TransCAD environment and save them in the desired formats (more information regarding file formats can be found in TransCAD Help).

The variables in the input tables should be given in the units required by the crash prediction models. The user can create a new column in the input table to store variable values in correct units. To create a new column with converted values, the following steps are needed.

1. Add an empty row to the dataview,
2. Fill the empty row with a formula,
3. Inside the formula box enter the appropriate conversion.

Equations for predicting annual crash frequencies are stored in parameter files which contain slopes, variables and their default values.
Executing the calculate crashes tool

Before executing the **Calculate Crashes** tool, the user needs to open the input segment network and intersection network tables in the TransCAD environment if segments and intersections are studied. If only one of the two is studied, then only the corresponding input file has to be opened. This can be done by clicking [FILE ➔ OPEN] ¹, and specifying the input files. If alternative networks are studied, then open all the input tables for the studied alternatives. The TransCAD software and PASS allow the use of multiple views. Once all the input files are opened in the TransCAD environment, the user can run PASS by clicking [Tools ➔ Add-ins ➔ PASS] ².

To predict the annual crash frequencies for a segment, use the Calculate Crashes option in the main menu of PASS (Figure 8-1).

![Figure 8-1 PASS main menu](image)

Selecting this option will display the **Calculate Crashes** interface window. The user needs to provide:

- Input segment table for the studied road network (leave blank if segments are not studied)
- Input intersection table for the studied road network (leave blank if intersection are not studied)
• Calibration factor file (leave blank if calibration factors are not needed)
• Folder with the files with model parameters
• Folder where the results are to be saved

![Figure 8-2 Calculate Crashes window](image)

**Important notes**

1. If PASS is run prior to opening the input tables in the TransCAD environment, no input segment table will appear in the dropdown menu in the **Calculate Crashes** option. To fix this problem, the user will need to close the PASS tool, open the desired input segment tables in the TransCAD environment and re-run PASS.

2. It is important to note that the column name entered in the parameter files specifying the facility classification (**Segment Type Field**) of the input segment table has to match the actual column in the input segment table with the facility classification; otherwise, an error message will result. If the user does not have his own models developed, he can always use the default segment parameter files saved in the C:/temp directory.

3. When using the input network file with a different format than HPMS and making use of the default segment parameter files, the user must modify the column names specifying the variables in his input segment network table. The user must also make sure he has a facility classification column by which the software can apply the appropriate equation. By default, the column name containing the facility
classification should be **SEG_TYPE**. If the user does not have a column with that exact name, he must modify within the TransCAD environment the input segment network table and fill the column with the facility classifications or modify existing models by specifying the column name under which the facility classification is stored in his input network files.

4. Each facility type is associated with one parameter file (up to three equations, one for each severity level). User has to make sure that the number of facilities in his input network tables is the same as the number of parameter files in the Parameter (Figure 8-2). When facility classification does not match the number of parameter files there will be either unused models (facility classification < number of parameter files) or empty calculation results in the output network table (facility classification > number of parameter files). To fix this problem see chapter 9.

5. Input intersection table should contain appended corrected intersection classification prior to crash prediction (see page 32).
9 Editing Models and Default Values

Different transportation agencies may prefer different crash prediction models suitable for their region or jurisdiction. Also, the crash prediction models for the same area required updating with time due to:

1. Changes in the transportation network needed to keep up with the growing travel demand,

2. Changes in the traffic safety caused by vehicle improvements and changing driver population and their skills,

3. Improvements in data that allow developing better crash prediction models.

Updating existing crash prediction models may require adding or removing variables, changing model parameters, changing default values, and adding new models for new facility types or additional crash severity levels. The crash prediction models can be modified with the PASS equation editor. Although the PASS equation editor does not allow changing the structure of the equations, it allows modifying the parameter and average values, and expanding and reducing the number of crash modification factors. The equation editor also allows removing existing and adding new crash prediction models. In the current version, PASS allows three severity levels input for models: IF (injury and fatal crashes), PDO (property damage crashes), and Total (all crashes). Parameter files contain descriptions of input variables, the column names in the input network table with the input values, parameter values, average values of the road characteristics and column name in the input network table containing facility classification.

To calculate crash frequencies, PASS applies appropriate equation to each facility type based on facility classification column (Segment type Field) specified by the user in the parameter files (Table Variables) which should match the column name in the input
network table containing facility classification. This allows the software to make the connection between the facility type and its corresponding parameter file. Each facility type is assigned one parameter file containing all the required parameters in the model. The software assigns parameter files to facility types in numerical order. The Type One facility will be assigned the No. 1 parameter file; the Type Two facility will be assigned the No. 2 parameter file, etc. Inside the parameter file, the user will also have to specify the column names in the input network table under which the input values for all variables used in the equation are stored. If the user does not have his own models developed, the tool provides default parameter files which were developed based on Indiana’s state network (HERS HPMS Input).

As mentioned above user has the power to modify existing models or create new models within the equation editor of PASS.

9.1 Modifying Segment Crash Prediction Models

To modify the segment parameter files, use the Segment Models option in the main menu of the PASS Tool (Figure 9-1).

![Figure 9-1 PASS main menu](pass.png)
Selecting the **Segment Models** option will allow you to access the parameter files interface window for segments (Figure 9-2). To display values stored in a desired parameter files (**Table Variables**), they must be loaded from a folder (**Models Folder**) and specific model within that folder where the values are stored (**Available Models**). To load the parameter file values from specific model, press the **Change** button, specify the folder where the desired parameter files are kept (**Models Folder**) and click **OK**. You will be able to see all models available within that loaded folder (**Available Models**). Select the desired model inside the **Available Models** scroll menu and press the **Load Values** button this will load the values for that specific model.
By default, the parameter files for all the facility types are loaded from the C:/output directory. If the parameter files you are using are stored in a different directory, change the path to that folder from which you are loading the parameter files by clicking Change button in the Models Folder entry. The Change button of Output Folder entry will allow you to choose the directory where your files are saved. By loading different folders user will be able to access all models saved in those folders and combine models saved in multiple folders to one folder with any desired alteration. When combining models from multiple folder locations to the same folder make sure the column containing facility classification (Segment Type Field) is the same for all parameter files stored within the same folder.

Switching between Table Variables windows

To navigate between parameter files interface windows, use the Next and Back buttons. User will be able to open as many parameter files interface windows as he wishes as long as the required fields for preceding parameter file windows have been filled. All parameter files stored in given folder are shown in the Available Models scroll menu. Click on the desired model and press the Load Values button to bring up values stored in that parameter file. User can load models from multiple folders Model Folder and save them to multiple folders Output Folder as long as he keeps track of what and where he is saving. It is encouraged to modify one folder at given time, however values can be loaded from multiple folders. This prevents from saving multiple facility classifications in one folder which will cause the Calculate Crashes option to malfunction.

Making changes

Parameter files for each facility type are saved separately. Once the user is done making changes in the parameter file interface window, he should save changes by pressing the Save button of Output Folder entry. When saving user specifies the Output Folder and facility type (Segment Type n) within that folder for which changes are to be made. If the user presses the Next or Back button prior to saving changes (Save button) all recent changes made in the parameter file interface window will not be written to the parameter
file however they will still appear if the user goes back to that parameter file window and will allow the user to save them without redoing them again. Any changes not saved will be erased once the user exits the Variable Tables (Exit button).

**Saving to the same directory**

If the user saves more then one parameter file for the same type of facility to the same directory, the previously saved parameter file for the same facility type will be overridden by the currently saved parameter file for the same facility type. Saving a parameter file interface window with changes for the same facility type to a different folder would create a new parameter file with the saved changes without deleting the existing parameter file. Parameter files for the same facility type saved at different locations allow the user to predict crashes using different models without having to go back, modify the parameter file interface window, override the existing parameter file, and redo crash prediction.

**Adding and removing model variables**

To add a variable to a model, the user must provide within the desired parameter file interface window the description, the name of the column under which the variable is stored in the input network table, the default value, and the slope for the intended severity. After entering the required inputs, the user should save changes by pressing the Save button. To remove a variable from a model, all inputs in the parameter file interface window for that variable should be erased. After removing the required entries, the user should save changes by pressing the Save button prior to moving to the next parameter file interface window. To clear all entries within a parameter file interface window inside any folder save a blank parameter file window in that same folder and load it to the parameter file where you clearing all values. You can also load the Segment Type9 (clear all) parameter file from the folder where the default models are stored. To load this folder provide inside the Variable tables:

1. Available Model: Segment Type8,
2. Highlighted Model: Clear all, and
3. Press the Load button.
9.2 Modifying Intersection Crash Prediction Models

To modify the intersection parameter files, use the Intersection Models option in the main menu of the PASS Tool (Figure 9-3).

![PASS main menu](image)

Figure 9-3 PASS main menu

The interface window for intersections looks almost identical to that of segments and the editing is the same as for segments. The only difference is that the intersection model require two traffic volumes to enter (major and minor roads traffic) while segment models require one traffic volume and segment length. Please refer to section 9.1 which gives explanations regarding loading, saving and modifying parameter files. When loading parameter files for intersections from specified directory they are saved under the name **Intersection Type(n)**, where n is the intersection type number, where as for segments they where saved under the name **Segment Type(m)**, where m is the segment type number.

9.3 Entering New Models

Driver behavior varies between states. Models developed in one state may not be applicable or as accurate for another state. Agencies across the U.S. might also have their own models developed, based on recent research, which they want to use in crash
prediction. PASS has been developed as a universal tool which allows the user to input his own models as long as the structure of the model follows equation 2.1.

To create new models, the user must create new parameter files since each parameter file is associated with a specific set of equations (one equation for each severity level). When entering new models user should enter model slopes, variables and default values making use of the equation editor features which simplify the process of entering values (see below).

**Creating new models**

Process of filling in parameter files is the same for segments and for intersection thus creating new segments parameter files will be explained and for intersections all operations are analogous. When entering new models, the user must specify following necessary inputs.

- First two Required Fields rows in *Variable Description*: description which will helps the user remember what variable is stored in specific row.
- First two Required Fields rows in *Column Name*: name of column under which input values for that variable are stored in the input network table.
- *Segment Type Field*: column name containing facility classification in the input network table
- Slopes for given severity and parameter values for Required Fields

In addition to necessary inputs user can make use of additional features allowing which simplify process of entering new models

- **Reference view**: view containing appropriate input network table in this case segment input network table. This view is used to extract all column names containing input values for all variables present in the table.
- **View Columns**: Column names for all input variables in the input network table are displayed here. Names of columns can be directly pasted to Column Name entry by activating the Column Name entry (click any letter key on the keyboard) and click on
the desired variable in the View Columns scroll down menu. This variable name will be pasted to *Column Name* field.

- **Description of facility type** in the input box under Segment Type n. This will help the user to remember which facility type is stored under which model. When loading models this description will appear in the **Highlighted Model** field of parameter file window.

- **Available Models** scroll down menu allows the user to make use of already created models by loading them. All **Available Models** are loaded from **Models Folder** directory path specified by the user.

---

**Table Variables**

<table>
<thead>
<tr>
<th>Variable description</th>
<th>Column name</th>
<th>IF</th>
<th>PDO</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intersection Type 1</td>
<td>Tw/SC</td>
<td>0.00925</td>
<td>0.00231</td>
<td>0.00028</td>
</tr>
<tr>
<td>Variable description</td>
<td>Column name</td>
<td>IF</td>
<td>PDO</td>
<td>Total</td>
</tr>
<tr>
<td>Major road approach volume (vehicle)</td>
<td>HTAADT</td>
<td>0.411</td>
<td>0.362</td>
<td>0.551</td>
</tr>
<tr>
<td>Minor road approach volume (vehicle)</td>
<td>HTAADT</td>
<td>0.274</td>
<td>0.152</td>
<td>0.206</td>
</tr>
<tr>
<td>Three leg intersection (binary)</td>
<td>LEE3</td>
<td>-0.546</td>
<td>-0.306</td>
<td>-0.365</td>
</tr>
<tr>
<td>Median width on major road (ft)</td>
<td>HSNEDWDT</td>
<td>-0.00942</td>
<td>-0.00028</td>
<td></td>
</tr>
</tbody>
</table>

---

**Figure 9-4** Parameter file interface window for segments
In addition to required fields user can enter additional variables which proved to be significant in his models. When entering new models, the user should provide in the parameter file interface window (Figure 9-4) the default values for each variable where the default input is available, a description of the variable, the column name under which the variable is stored in the input network table, and all variable slopes for specific severity. All these additional variables can be entered using the equation editor features described above.

Reclassifyng facilities in your data set

Reclassifyng facility types in the input network table requires the user to create new models because PASS applies the appropriate equation for each facility based on the facility type column in the input network table and Segment/Intersection Facility Type entry in the parameter files. To reclassify facilities the user should enter the name of the column containing new facility classification in his input network table. To minimize the time required for inputting values into the parameter file interface windows, the user may load already existing parameter files which contain the variables description or start from scratch using the parameter files entry features. Parameter files containing models for new facility classification should be saved in a new folder where no other parameter files are stored.

Important notes

1. Prior to running the equation editor for segment or intersections make sure that the input network tables (segment and intersection) are opened in TransCAD environment. This will allow the user to make use of View Column scroll down menu and select the appropriate column name containing input values for variables used in the equations without having to remember the names and typing them in manually.

2. Make sure that the appropriate input network table is selected in the Reference View. Column names in the View Column scroll menu are extracted from the Reference View entry.

3. PASS tool prevents the user from moving to the next parameter file if the required fields for current parameter file have not been filled.
10 Calibration Factors

The crash prediction models may require recalibration to account for changes in the safety relationships since the time models were developed. Another reason for recalibration is focusing safety prediction on a study area by matching the crashes in the study area with the crashes reported there. To facilitate this operation, PASS has been equipped with a calibration module. The integrated calibration process compares the number of reported crashes with the initial predictions calculated for the traffic and network conditions that are representative of the period with crash reports. The original predictions are adjusted with a set of calibration factors to match the reported crashes as close as possible. One calibration factor corresponds to a, so called, network partition. The network is divided into calibration partitions by facility type and additional criteria defined by the user. The network partitions can overlap which means that a segment or intersection may belong to more than one partition. The original prediction is modified with the calibration factors according to the following equation:

\[ A = K_1 \cdot K_2 \cdots K_n \cdot A_0 , \]

where:
\( A \) = adjusted prediction,
\( K_i \) = calibration factor for partition \( i \); a given segment or intersection belongs to \( n \) partitions,
\( A_0 \) – initial prediction.

PASS allows two types of calibration:

1. **Standard calibration** - only facility types constitute partitions; one calibration factor per facility type (crash prediction model) is developed;

2. **User-defined calibration** - user defines additional partitions; more than one calibration factors are used.
Developed calibration factors and their descriptions are stored in a calibration file to be used in future calculations. To develop calibration factors, the user needs input network tables (segments and intersections) containing reported crash counts and corresponding original predictions in desired crash severity categories: IF, PDO, or Total. To develop calibration factors and create the calibration file, select the Calibrate Models option (Figure 10-1).

![Figure 10-1 Pass main menu](image)

Pressing this option will display Calibration Factors window (Figure 10-2) where the user should enter the following inputs.

- Input segment network table: *Input Dataview (Segments)*
- Input intersection network table: *Input Dataview (Intersections)*
- Column name in the input segment table containing actual IF crash counts: *Columns with Crash Counts > If Crashes (Segments)*
- Column name in the input intersection table containing actual IF crash counts: *Columns with Crash Counts > If Crashes (Intersections)*
- Column name in the input segment table containing actual PDO crash counts: *Columns with Crash Counts > PDO Crashes (Segments)*
- Column name in the input intersections table containing actual PDO crash counts: 
  *Columns with Crash Counts > PDO Crashes (Intersections)*

- Column name in the input segment table containing calculated IF crash counts: 
  *Columns with Calculated Crashes > If Crashes (Segments)*

- Column name in the input intersection table containing calculated IF crash counts: 
  *Columns with Calculated Crashes > If Crashes (Intersections)*

- Column name in the input segment table containing calculated PDO crash counts: 
  *Columns with Calculated Crashes > PDO Crashes (Segments)*

- Column name in the input intersections table containing calculated PDO crash counts: 
  *Columns with Calculated Crashes > PDO Crashes (Intersections)*

- Column name in the input segment table containing facility classification: 
  *Columns with Calibration Partitions > Facility type (Segments)*

- Column name in the input intersection table containing facility classification: 
  *Columns with Calibration Partitions > Facility type (Segments)*

- Output folder where to store the calibration factor file: *Output directory*. User can change the location of the output folder by clicking the **Change** button

- **Number of years** is the period length with the crash data used in the calibration process.

- **Calibration parameter** is used as a stopping criterion in the iterative calibration process. It is the maximum allowed relative difference between two consecutive solutions. **NOTE:** This entry is used only for user-defined calibration.

- **Estimation parameter** is the maximum percent standard deviation of the annual crash frequency estimated based on the number of reported crashes in a user-defined network partition. The actual percent standard deviation for a network partition is equal to 
  \[
  \frac{100}{\# \text{years with crashes} \cdot \sqrt{\# \text{crashes in partition}}}
  \]. This setting affects the
statistical confidence of the obtained calibration factors. If the user wants the percent standard deviation to be at most equal to the estimation parameter, the number of reported crashes in any partition should be at least

\[
\left( \frac{100}{\text{number of years with crashes} \times \text{estimation parameter}} \right)^2.
\]

For example, for estimation parameter 5% and three years with crash data, the number of crashes in any network partition should be at least 45. The PASS tool will issue a warning if any of the network partitions has the number of crashes lower than the desired minimum.

Figure 10-2 Calibration factors window
Standard calibration

Standard calibration does not require specifying partitions. All calibration partitions are already defined by the classification of segments and intersections. The total numbers of recorded crashes \( \Sigma A_r \) and predicted crashes \( \Sigma A_0 \) at each facility type are calculated and the calibration factor \( f \) for each facility (partition) is calculated as \( f = \frac{\Sigma A_r}{\Sigma A_0} \). To run the standard calibration, leave blank all the User Defined Partitions dropdown menus in the “Calibration Factors” interface window. For standard calibration user does not need to provide the Maximum Estimation Error (%) since the standard calibration does not involved iterative calculations. Once the specified the required input is entered, press the Run button. The calibration factors obtained for all types of segments and intersections are stored in a calibration file.

User-defined calibration

User-defined calibration is used when a dedicated calibration factor should be applied to a specific part of the network or collection of facilities that share common characteristics not included in the crash prediction model. User-defined calibration will emphasize the user-defined partitions (such as a study area) and will allow for more accurate prediction of crashes in these network partitions. To develop a calibration file containing user-defined partitions, the user must add additional columns to the input segment and intersection tables. Each column corresponds to a single user-defined partition and it contains zeros and ones. The value of one indicates that a given segment or intersection belongs to the partition defined by the column while the zero value indicates otherwise. To add additional columns do the following.

1. Appendix an empty row inside both network tables (segment and intersections).
   
   a) Press the Dataview button inside TransCAD environment.
   b) Select the Modify Table… option.
   c) Press the Add Field button and in the Name entry type the desired name of the column.
   d) Click the OK button and confirm by further selecting YES option
2. Fill the empty row with condition based on other existing columns in the table or manually add ones and zeros in the column if the record does or does not belong to the calibration partition. To enter the desired condition due the following:

   a) Right click with mouse the column where you want to enter a specific condition.
   b) Select the Fill… option.
   c) Mark the radial button Formula which will bring up Formula editor window.
   d) Inside the Formula editor specify the desired user conditions for user defined partitions.

When creating a column for a user-defined calibration partition, an identically-named column for the user-defined partition must be added to both the input tables (segments and intersections) even if one of the two input tables is to contain all zeros in the added column. The additional columns representing user-defined partitions should be named and these names should be selected from the User Defined Partition dropdown list (see Figure 10-3) in the PASS user interface. The user can defined up to 50 partitions.

![Figure 10-3 Calibration Factors user defined partitions](image-url)
Pressing the **Next** button brings more entries to enter user defined partitions as shown in Figure 10-3. To obtain calibration factors with user-defined calibration partitions, press the **Run** button after entering all desired user-defined partitions.

11 Software Demonstration - A Corridor Study

Use of the INPASS and PASS tools is illustrated through its application to an example study of the US 27 road corridor in the eastern part of Indiana. Safety of the corridor is predicted for 2030 for two alternatives A and B. Alternative A is the do-nothing alternative where no changes are made to the current roads. In Alternative B, the two-lane sections of US 27 are converted to four-lane facilities and the four-lane sections are upgraded to the AASHTO-recommended standards for divided arterial roads. The upgrading of cross-sections followed several rules:

1. If outside curb is present, the upgraded cross-section should retain a curb. A curbed median of 18 feet should be constructed if the existing median is narrower or there is no median.

2. If outside shoulder is present, it should have a minimum width of eight feet. A narrower outside shoulder (including no shoulder) is widened to the minimum width. An outside shoulder wider than the minimum width retains its current width.

3. A median should be at least 18 feet wide; narrower medians (including no medians) are upgraded to 18 feet. Existing curbed medians after upgrading remain curbed. Other median treatments also remain unchanged.

4. Inside shoulder should be at least 4 feet wide. A narrower inside shoulder is widened to 4 feet while inside shoulder wider the 4 feet retain their current width.

5. Curbed one-way facilities remain unchanged. If there is no curb, then the outside shoulder should have a minimum width of 8 feet, narrower outside shoulders are upgraded while wider outside shoulder retain their width.

A summary of the network changes in Alternative B is presented in Table 11-1. The intersections along the studied corridor have been modified to accommodate the changes made to road segments (increased number of lanes, upgraded shoulders, new or widened medians, etc.). No intersection-specific modifications have been considered such as roundabouts, channelization, signalization, etc.
Table 11-1 Summary of roadway changes in the US 27 corridor (Alternative B)

<table>
<thead>
<tr>
<th>Facility Type</th>
<th>SEG_TYPE</th>
<th>Urban Cross-section (Curb Present)</th>
<th>Total Length in miles (# of segments)</th>
<th>Roadway improvements – total miles (# of segments)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Adding two traffic lanes</td>
</tr>
<tr>
<td>Rural two-lane</td>
<td>1</td>
<td>NO</td>
<td>66.71 (94)</td>
<td>66.71 (94)</td>
</tr>
<tr>
<td>Rural multi-lane</td>
<td>2</td>
<td>NO</td>
<td>18.46 (27)</td>
<td>NA</td>
</tr>
<tr>
<td>Urban two-lane</td>
<td>4</td>
<td>YES</td>
<td>0.45 (4)</td>
<td>0.45 (4)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NO</td>
<td>13.05 (68)</td>
<td>13.05 (68)</td>
</tr>
<tr>
<td>Urban multi-lane</td>
<td>5</td>
<td>YES</td>
<td>4.43 (28)</td>
<td>NA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NO</td>
<td>9.48 (43)</td>
<td>NA</td>
</tr>
<tr>
<td>One-way</td>
<td>7</td>
<td>YES</td>
<td>3.03 (21)</td>
<td>NA</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NO</td>
<td>7.73 (51)</td>
<td>NA</td>
</tr>
</tbody>
</table>
In the example study, we predict the annual frequencies and costs of crashes in Alternative A (existing road network with the future volumes) and in Alternative B (improved road segments). We calculate the difference in the crash frequencies between the two alternatives and then convert that difference into the annual monetary savings in 2030.

The use of the software for the example corridor study is organized in three parts.

1. **Part I** explains predicting crash frequencies. The starting point to this analysis is the input segment tables for both the alternatives and available calibration factors.

2. **Part II** shows how to produce the calibration factors used in Part I. In this part, the user is provided with the current road network and recently recorded crashes assigned to segments and intersections of this network.

3. **Part III** guides through the process of assigning crashes to the current network segments and intersections. Assigned crashes were used in Part II to produce the calibration factors. A subset of source crash data is provided for the illustration purpose.

![Figure 11-1 Map representation of studied section US27](image-url)
11.1 PART I  Predicting Crash Frequencies

In this part, we evaluate the safety benefits of upgrading the US 27 roadway. The upgrading includes converting the two-lane two-way road segments to four-lane segments and upgrading four-lane cross-sections to AASHTO recommended standards. PASS and INPASS tools are used to facilitate the analysis. For convenience, crash predictions are done for the entire state network. After obtaining the crash predictions, the results for the US 27 segments and intersections are selected from the entire network and summarized. Two alternatives A and B are considered. Alternative A is the do-nothing alternative and Alternative B is the upgraded US 27. Crashes are predicted using the Indiana safety performance functions developed based on 2003, 2004 and 2005 crash and HERS HPMS data. The crash predictions are summarized, compared, and displayed graphically using standard TransCAD features.

File management

Prior to starting this example create a PART_I folder with additional subfolder as shown in Figure 11-2. This folder and its structure will allow you store and find the result files easily and will guide through the whole process.

![Figure 11-2 Folder structure for Part I example](image)
The starting point of this analysis is two input geographic file segment tables representing each alternative. Alternatives analyzed here are the do nothing alternative (alternative A) and the conversion of all US 27 two lane two way segments to four lane with improvements made to the cross-section and upgrade of all existing four lane facilities cross-sections not meeting AASHTO guidelines to respective recommended values for this facility type (alternative B). The first step in the analysis is to expand the segment tables using the INPASS tool.

**Expanding segments tables**

Segment tables need to be expanded to contain all the model variables used by the PASS tool for crash prediction. Additional variables which are used by the PASS tool default equations but are not present in the input segments table are added by the Expand Segments Table module. Expand Segments Table option also assigns appropriate facility classification to each segment based on its characteristics. This facility classification is used to apply appropriate equation for given segment. Both alternative network segments tables need to be expanded. To run any options of the PASS or INPASS tool, you need to open in TransCAD environment the tables which you will be working with. This can be done by pressing File ➔ Open… and specifying the location where the files are stored. The files you will be working on are stored in the PART_I/alternative A, and in PART_I/alternative B folder. To see the appropriate file types change the file type to Geographic file.

Open the INPASS tool by pressing Tools ➔ Add-ins… ➔ INPASS. To expand segment table press the Expand Segments Table option from the INPASS menu (Figure 11-3). Expand the segments table for alternative A (Figure 11-4) and alternative B (Figure 11-5). Since you can only expand one segment table at a time, you will need to execute this module twice. Store the output of this step for alternative A in PART_I/alternative A/Expand Segments Table, and for alternative B in PART_I/alternative B/Expand Segments Table. When the tool asks you to display the results click on YES this will show you the generated expanded segments table.
When you're done executing this step you will have two files generated one for alternative A and one for alternative B with appended facility classification and additional variables used by the default equations for crash prediction in proceeding steps. The outputs from this step are stored under the `EPANDED_SEGMENT_DATE`
name. Now close all open tables. The next step is to create intersection tables for each alternative.

Creating intersection tables

To predict crashes for intersections, intersections tables need to be developed for both alternatives. Intersection tables are developed from segment tables based on hidden node layer. This node layer contains intersections and inventory nodes. During the Create Intersections Table step intersections are selected and appropriate characteristics for them are generated based on segment table characteristics. The output is written to a database file which can be viewed in TransCAD environment. Prior to creating each intersection table open the alternative A geographic segment table and alternative B geographic segment table. These are the same tables you used in the Expand Segments Table module in previous step and can be found in PART_I/alternative A, and in PART_I/alternative B folder respectively.

Another important step prior to generating the intersection table is appending the node information to each segment table from which the intersection table is generated. This can be done by within each alternative geographic segment table.

1. Click on DataView
2. Select Formula Fields…
3. Choose Node Fields…
4. Highlight ID and click OK

Note you have to do this twice once for each alternative. To create intersection tables use the Create Intersections Table module (Figure 11-6) and run this feature twice, once for each alternative (Figure 11-7, Figure 11-8). Store the output of this step for alternative A in PART_I/alternative A/Create Intersections Table, and for alternative B in PART_I/alternative B\Create Intersections Table.

Having created intersection table for each of the alternatives you will have a complete network representation for both alternatives. When the tool asks you to display the results click NO. We will reopen these tables in the next step.
Figure 11-6 INPASS menu Create Intersections Table module

Figure 11-7 Creating intersections for alternative A

Figure 11-8 Creating intersections for alternative B
When you’re done executing this step you will have two intersection files generated one for alternative A and one for alternative B. The outputs from this step are stored under the NODE_ DATE name. Because existing segment table (HERS HPMS Input) from which both alternatives segments tables where develop do not contain correct classification of control type at the segments, generated node classification might in some cases give incorrect result. To account for this issue a correct intersection classification was developed and can be appended to generated intersection tables for both alternatives.

To append correct intersection classification to the intersection table for alternative A do the following.

1. Click on File and select Open
2. Specify the dBASE file type
3. Find in PART_I folder directory INT_CLASS_FACILITY.DBF and click Open
4. Repeat File⇒Open
5. Find in PART_I/alternativeA/Create Intersections Table folder directory NODE_DATE.DBF and click Open
6. Select Dataview and click on Join (Figure 11-9)
7. Save the joined view as C_INT_A
8. Close all files except for INT_CLASS_FACILITY.DBF

Repeat the above bullets for alternative B with difference being that the intersection table for alternative B has to be joined with the INT_CLASS_FACILITY.DBF table. Alternative B intersection table can be found under PART_I/alternativeB/Create Intersections Table folder directory with the name NODE_DATE.DBF. Save the joined view as C_INT_B. Note that the DATE in the file name (NODE_DATE.DBF) will be different for alternative A and alternative B since both where not created at exactly the same time. Close all the files.

Now you will have a complete representation of the network (segments and intersections with correct classification) for each of the alternatives. The next step is to calculate initial predictions for segments and intersections for each of the alternatives. As in previous
steps you can only predict crashes for one alternative at a time, so this step will have to be run twice, once for each alternative.

![Figure 11-9 Joining correct intersection classification to the intersection table](image)

**Figure 11-9 Joining correct intersection classification to the intersection table**

### Calculating initial predictions

To determine predictions for current network use the **Calculate Crashes** option. Predictions can be determined simultaneously for segment and intersections when input for both is specified. To determine default models predictions for alternative A:

1. Open in TransCAD environment alternative A expanded segments table (PART_I/alternative A/Expanded Segments Table) and alternative A intersection table C_INT_A stored in (PART_I/alternative A/Create Intersections Table).
2. Specify where the desired parameter files are stored (Default values folder)
3. Specify where you want the output to be saved (PART_I/alternative A/Calculate Crashes)

Figure 11-10 presents required inputs.
Running this option will generate two files in `PART_I\alternativeA\Calculate Crashes` directory folder: `INTERSECTION CRASH_DATE.DBF` (containing default models intersection predictions appended to intersection table for alternative A) and `SEGMENT CRASH_DATE.DBF` (containing default models segment predictions appended to expanded segment table for alternative A).

Now you will need to repeat this step for alternative B (Figure 11-11) with expanded segment table (step2) and intersection tables (step3) corresponding to this alternative. Remember to open those two tables in TransCAD environment prior to repeating this step for alternative B. The above mentioned input files can be found in the: `PART_I\alternativeB\Expand Segments Table` (alternative B expanded segment table) and `PART_I\alternativeB\Create Intersections Table` (alternative B intersection table) folder directories.
Running this option will generate two files in PART_I/alternativeB/Calculate Crashes directory folder:  INTERSECTION CRASH_DATE.DBF (containing default models intersection predictions appended to intersection table for alternative B) and SEGMENT CRASH_DATE.DBF (containing default models segment predictions appended to expanded segment table for alternative B). Initial predictions are based on default equations which were developed for Indiana state network using 2003, 2004 and 2005 reported crashes. User has the ability to calibrate initial predictions which will most likely provide significant difference when applying predictions with standard calibration if different then default models facility classification is used or when crash data for future years is available. Applying calibration in crash prediction will be explained in Part II. At this point we will concentrate on numerically and graphically comparing both alternatives default model predictions.

To prevent confusion when joining tables in the future step of presenting results insert in front of the output file names a letter designating the alternative for which it was developed. This can be done by renaming the two output files for each alternative outside of TransCAD. For alternative A you would insert a letter A in front of the output file name and for alternative B you would insert a letter B (A_SEGMENTS CRASH_DATE.DBF, B_INTERSECTION CRASH_DATE.DBF etc). The files you need to rename are stored in PART_I/alternativeA/Calculate Crashes folder for alternative A and in PART_I/alternativeB/Calculate Crashes folder for alternative B. Difference between predictions for both alternatives will be compared by appending to alternative A only relevant columns from alternative B table containing default crash predictions and densities and using those column in the calculation.

Presenting results

First we will calculate crash densities and add these records to tables for both alternatives. Open alternative A segment table (A_SEGMENT CRASH_DATE_A.DBF) and intersection table (A_INTERSECTION CRASH_DATE_A.DBF) which can be found in PART_I/alternativeA\Calculate Crashes directory folder. Add four new columns by clicking Dataview ➔ Modify Table
and pressing three times Add fields button. Name the new fields as CRIF, CRPDO, CRTOTAL and COST. Make sure you specify these fields to be a real number. Fill the new fields with following formulas accordingly (right click with mouse \(\text{Fill} \rightarrow \text{Formula})

\text{In Segment table}

\begin{align*}
\text{CRIF} &= [IF] \ast 1000000000 \div (\text{Length} \ast 365 \ast H33AADT) \\
\text{CRPDO} &= PDO \ast 1000000000 \div (\text{Length} \ast 365 \ast H33AADT) \\
\text{CRTOTAL} &= Total \ast 1000000000 \div (\text{Length} \ast 365 \ast H33AADT) \\
\text{COST} &= \text{if } (\text{SEG_TYPE}>0 \text{ and } \text{SEG_TYPE}<4) \text{ then } 78000 \ast [IF] + 6500 \ast PDO \text{ else } 48000 \ast [IF] + 6500 \ast PDO
\end{align*}

Click OK and confirm with Yes

\text{In Intersection table}

\begin{align*}
\text{CRIF} &= [IF] \ast 1000000000 \div ((H1AADT+H2AADT) \ast 365)) \\
\text{CRPDO} &= PDO \ast 1000000000 \div ((H1AADT+H2AADT) \ast 365)) \\
\text{CRTOTAL} &= Total \ast 1000000000 \div ((H1AADT+H2AADT) \ast 365)) \\
\text{COST} &= \text{if } H3URBRUR=0 \text{ then } 78000 \ast [IF] + 6500 \ast PDO \text{ else } 48000 \ast [IF] + 6500 \ast PDO
\end{align*}

Click OK and confirm with Yes

Open alternative B segment table (B\_SEGMENT CRASH\_DATE\_A.DBF) and intersection table (B\_INTERSECTION CRASH\_DATE.DBF) which can be found in PART\_I\_alternativeB\_Calculate Crashes directory folder. Add three new columns by clicking Dataview \(\rightarrow\) Modify Table and press three times Add fields button. Name the new fields as CRIF, CRPDO, CRTOTAL and COST. Fill the new fields with following formulas accordingly (right click with mouse \(\text{Fill} \rightarrow \text{Formula})

\text{In Segment table}

\begin{align*}
\text{CRIF} &= [IF] \ast 1000000000 \div (\text{Length} \ast 365 \ast H33AADT) \\
\text{CRPDO} &= PDO \ast 1000000000 \div (\text{Length} \ast 365 \ast H33AADT) \\
\text{CRTOTAL} &= Total \ast 1000000000 \div (\text{Length} \ast 365 \ast H33AADT) \\
\text{COST} &= \text{if } (\text{SEG_TYPE}>0 \text{ and } \text{SEG_TYPE}<4) \text{ then } 78000 \ast [IF] + 6500 \ast PDO \text{ else } 48000 \ast [IF] + 6500 \ast PDO
\end{align*}

Click OK and confirm with Yes
**In Intersection table**

\[
\text{CRIF} = \frac{[IF] \times 100000000}{((H1AADT+H2AADT) \times 365)}
\]

\[
\text{CRPDO} = \frac{PDO \times 100000000}{((H1AADT+H2AADT) \times 365)}
\]

\[
\text{CRTOTAL} = \frac{\text{Total} \times 100000000}{((H1AADT+H2AADT) \times 365)}
\]

\[
\text{COST} = \begin{cases} 78000 \times [IF] + 6500 \times PDO & \text{if } H3URBRUR = 0 \\ 48000 \times [IF] + 6500 \times PDO & \text{else} \end{cases}
\]

Click **OK** and confirm with **Yes**

This will append crash rates and monetary cost to segments and intersection tables for both alternatives. Now we will determine the difference in crash counts and costs between both alternatives by joining both alternatives tables with each other, once for segments and once for intersections. When the relative difference compared to the do nothing alternative is known we can determine the safety benefit of our initiative which was conversion of two lane facilities and upgrading of cross-sections for existing and planned upgraded facilities. To find the difference in crash counts follow the proceeding steps.

1. Press **Dataview**, 
2. Select **Join** option, 
3. Join intersection table for alternative B with intersection table for alternative A (Figure 11-12),

![Join window](image)

**Figure 11-12 joining intersection tables for both alternatives**
4. Select only the relevant columns from alternative B to append and save the joined view as **RESULTS_Intersections** in **PART_I** folder. To select relevant columns: select the joined view window, click on the **Dataview**, select **Fields**, press the **Clear** button, drag to the right side all columns belonging to **A_INTERSECTIONS CRASH_DATE.DBF** by highlighting and clicking the **ADD>>** button and also add from **B _INTERSECTIONS CRASH_DATE.DBF** columns containing crash predictions, these are all columns from **B _INTERSECTIONS CRASH_DATE.IF** down till the end of all fields available (Figure 11-13).

![Dataview Fields](image)

**Figure 11-13 Selecting relevant columns for results analysis**

Next join segments table for alternative B with segments table for alternative A (Figure 11-14).

![Join](image)

**Figure 11-14 Joining segments tables**
5. Select only the relevant columns from alternative B to append and save the joined view as **RESULTS_Segments** in **PART_I** folder. To select relevant columns: select the joined view, click on the **Dataview**, select **Fields**, press the **Clear** button, drag to the right side all columns belonging to **A_SEGMENTS CRASH_DATE.DBF** by highlighting and clicking the **ADD>>** button and also add from **B_SEGMENTS CRASH_DATE.DBF** columns containing crash predictions, these are all columns from **B_SEGMENTS CRASH_DATE.IF** down till the end of all fields available (Figure 11-15).

![Dataview Fields](image)

*Figure 11-15 Selecting relevant columns for results analysis*

6. Now close all files and open **RESULTS_Segments** and **RESULTS_Intersections** from **PART_I** folder.

7. In **RESULTS_Segments** table just as you did before add five new columns (Dataview modify table three times press Add Field).

8. Name the new columns as **DCRIF**, **DCRPDO**, **DCRTOTAL**, **BENEFIT** and **BENEFITPM**. Fill those columns with the following conditions (right click with mouse Fill Formula radial button): **DCRIF** = **CRIF** - **CRIF1**, **DCRPDO** = **CRPDO** - **CRPDO1**, **DCRTOTAL** = **CRTOTAL** - **CRTOTAL1**, **BENEFIT** = **COST** - **COST1** and **BENEFITPM** = \( \frac{(COST - COST1)}{LENGTH} \). Confirm with OK.

9. Create a selection set for US 27 segments by clicking **Selection** ⇒ **Select by condition** and typing in **H10 contains”-U-027-“** confirming with **OK**. This will select only US 27 Segments.
10. Run statistics by clicking Compute Statistics tab. Look at the summation of DCRIF, DCRPDO, DCRTOTAL, and BENEFIT this will indicate savings in crash counts and dollar value for segments. Note that you can save this summary file.

Now repeat the above step for RESULTS_Intersections table. In RESULTS_Intersections table just as you did before with the alteration that BENEFITPM is not calculated add four new columns (Dataview ➔ modify table ➔ three times press Add Field).

1. Name the new columns as DCRIF, DCRPDO, DCRTOTAL, and BENEFIT. Fill those columns with the following conditions (right click with mouse ➔ Fill ➔ Formula radial button): DCRIF = CRIF-CRIF1, DCRPDO = CRPDO -CRPDO1, DCRTOTAL = CRTOTAL –CRTOTAL, and DBENEFIT = COST-COST1. Create a selection set for US 27 intersections by clicking Selection ➔ Select by condition and typing in H12LINK contains”-U-027-“ or H13LINK contains”-U-027-“ or H14LINK contains”-U-027-“ or H15LINK contains”-U-027-“ confirming with OK. This will select only US 27 Intersections.

2. Run statistics by clicking Compute Statistics tab. Look at the summation of DCRIF, DCRPDO, DCRTOTAL, and BENEFIT this will indicate savings in crash counts for intersections. Note that you can save this summary file.

Table 11-2 through Table 11-4 give quantitative comparison of both alternatives.

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Rural facilities</th>
<th>Urban facilities</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>IF</td>
<td>PDO</td>
<td>IF</td>
</tr>
<tr>
<td>Current network</td>
<td>41.78</td>
<td>152.28</td>
<td>197.72</td>
</tr>
<tr>
<td>Alternative A (2030)</td>
<td>58.34</td>
<td>205.77</td>
<td>226.64</td>
</tr>
<tr>
<td>Alternative B (2030)</td>
<td>55.68</td>
<td>110.62</td>
<td>159.56</td>
</tr>
<tr>
<td>Crashes saved (2030)</td>
<td>2.66</td>
<td>95.15</td>
<td>67.08</td>
</tr>
</tbody>
</table>
Table 11-3 Summary of intersection crash predictions

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Rural facilities</th>
<th>Urban facilities</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>IF</td>
<td>PDO</td>
<td>IF</td>
</tr>
<tr>
<td>Current network</td>
<td>7.53</td>
<td>24.10</td>
<td>46.95</td>
</tr>
<tr>
<td>Alternative A (2030)</td>
<td>10.94</td>
<td>35.08</td>
<td>55.13</td>
</tr>
<tr>
<td>Alternative B (2030)</td>
<td>10.30</td>
<td>31.88</td>
<td>55.13</td>
</tr>
<tr>
<td>Crashes saved (2030)</td>
<td>0.64</td>
<td>3.20</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Table 11-4 Monetary safety benefit of alternative B relative to alternative A.

<table>
<thead>
<tr>
<th>Severity</th>
<th>Number of crashes saved</th>
<th>Average cost of crash</th>
<th>Safety benefit ($)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Rural</td>
<td>Urban</td>
<td>Rural</td>
</tr>
<tr>
<td>Injury or Fatal</td>
<td>3.3</td>
<td>67.08</td>
<td>$78,000</td>
</tr>
<tr>
<td>Property Damage</td>
<td>98.35</td>
<td>412.47</td>
<td>$6,500</td>
</tr>
<tr>
<td>All</td>
<td>101.65</td>
<td>479.56</td>
<td>-</td>
</tr>
</tbody>
</table>

To display results graphically first close all files. Reopen the RESULTS_Intersections table from PART_I folder and when TransCAD asks you if you want to create a geographic file click on YES. Save this file with the same name in PART_I folder. This will generate a geographic file containing all information as obtained above for intersections.

To display results for segments is more challenging since there is a hidden node layer in the geographic segment table which does not get transferred when executing each module. Open the geographic segment table for alternative A stored in PART_I /alternativeA folder directory and RESULTS_Segments table stored in PART_I folder directory. Join these two files together (Dataview ➔ Join) (11-16). Now select only
RESULTS_Segments columns (Dataview→Fields→Clear) selecting all fields from RESULTS_Segments.ID down till the end of all available fields), other columns will be duplicates if not dropped since they represent network characteristics which are present in both tables. Export the joined view to a geographic file (11-18) by clicking Tools→Export and close all windows.

11-16 Joining tables together

11-17 Selecting only RESULTS_Segments columns
Now having both result files (RESULTS_Segments and RESULTS_Intersections) saved as geographic files we will create a subset for US 27 so only segments and intersections belonging to this corridor can be viewed. To generate such subsets, which can be viewed on a map, separate geographic files for US 27 segments and for intersections will be created. We will start working on segments. First create a selection for segments belonging to US 27 and export this selection to a geographic file by doing the following steps.

1. Open RESULTS_Segments (File ➤ Open),
2. Click on Selection,
3. Choose Select by condition,
4. Inside the condition box enter: H10_LRSID contains"-U-027-",
5. Name this selection US27segments,
6. Select Tools,
7. Choose Export and export US27segments selection to a Standard Geographic File,
8. Click on OK, and
9. Save the file as US27segments in the PART_I folder.
Figure 11-19 Exporting US27 segments selection to a geographic file

This will save all the US27 segments to a geographic file stored in the PART_I folder. Now let us move on to US27 Intersections. To create a separate geographic file for US 27 Intersections do the following.

1. Open RESULTS_Intersections (File→Open),
2. Click on Selection,
3. Choose Select by condition,
4. Inside the condition box enter: H12LINK contains"-U-027-" or H13LINK contains"-U-027-" or H14LINK contains"-U-027-" or H15LINK contains"-U-027-",
5. Name this selection US27intersections,
6. Select Tools,
7. Choose Export and export US27intersections selection to a Standard Geographic File,
8. Click on OK,
9. Save the file as US27intersections in the PART_I folder.

Now you will have US27 segments and intersections saved as geographic files. To display these results clear all files in the TransCAD window. Open US27segments geographic file from the PART_I folder. Now we will open the US27intersections in the same map as US27segments.

1. Click on Map and select Layers,
2. Inside this window click the **Add Layer** button and specify the location where the **US27 intersections** geographic file is stored by double clicking on it. This should add US27 intersections to the map already containing U27 segments.

Now we will change the display style for intersections from dots to circles and increase the font size so they can be better recognized.

1. Click on Style button inside the **Layers** window and select Webdings **Font** with **Size** set to 8 and **Italic** format (Figure 11-20).

![Figure 11-20 Changing intersections display](image)

2. Confirm with **OK**

Now we are going to color code segments with the total crash density difference between alternative A and alternative B which will show the reduction (benefit) of crash density on each link. In addition to color coding we will display the actual value representing the reduction in total crash density for segments. Then we are going to display on the same map the reduction in total crash counts for each intersection. For segments do the following.

1. Click on Color Theme Map Wizard icon and enter the following setting in the **Settings** (Figure 11-21) and **Style** (Figure 11-22) tabs.
2. Confirm with **OK**.
To display the actual value representing the reduction in crash density for each link click on the Automatic Labels icon and select **BENEFITPM** Field to be displayed (Figure 11-23). This field contains the monetary benefit per mile on each link.

![Automatic Labels (Layer: alternativeA)](image)

**Figure 11-23 Displaying benefit per mile value on each link**

Now to display the reduction in total crash counts for intersections do the following.

1. Click on **Map**
2. Select **Layers**
3. Click the cursor on the intersection layer and move it up by clicking the **Move Up** button.
4. Confirm with **Close**. You will be able to access fields in this layer in the Automatic Labels icon.

To display the actual value click on the Automatic Labels icon and select **BENEFIT Field** to be displayed. This field contains monetary benefit on each intersection. Choose the settings as specified in Figure 11-24 and confirm with **OK**.
Figure 11-24 Displaying crash benefit value for intersections

Now you can inspect the results graphically which depict monetary density per mile for each link and monetary benefit for each intersection. Note that you could have used any other values stored in the table to display on the map.
Figure 11-25 Graphical representation of results for portion of the studied US27 corridor
11.2 PART II Calibration of Crash Prediction Equations

Default Indiana crash prediction equations (safety performance functions) have been developed for the entire Indiana network based on 2003, 2004 and 2005 crash data. Each year new crash data is available which may be used to recalibrate the crash prediction equations. Also in some instances user may wish to put specific emphasis on selected parts of the network such as studied corridors or selected counties. The PASS tool has been equipped with features that allow producing calibration factors that are used together with the default predictions equations to better reflect safety relationships.

In our example we are going to develop calibration factors for facility types (standard calibration) and additional calibration factors to place more emphasis in crash prediction on the studied US 27 corridor and specifically on segments and intersections belonging to this corridor (user defined calibration). The produced calibration factors will be placed by PASS to two calibration files – one for road segments and another one for road intersections. These factors are then used jointly with the default prediction equations. These calibration factors are developed by utilizing predictions produced by the default equations with the actual recorded crashes cumulated in network partitions. Partitions represent facility types and user-defined parts of the road network.

In our example, we are starting with two input tables – one for segments and another one for intersections. These input files contain crash predictions obtained in the default prediction equations and crashes recorded for three years (2003, 2004, and 2005). Segments input file is stored under SEG_NET_CAL.DBF in the PART_II folder and intersections input file is stored under INT_NET_CAL.DBF in the PART_II folder (Figure 11-26).

Figure 11-26 Folder structure for PART_II example
Standard calibration

First we are going to develop a standard calibration file which calculates a calibration factor for each facility type and severity level. To develop standard calibration file for the entire network segments and intersections crash data needs to be provided as input in the same step. Standard calibration file for the entire network can be obtained through the following steps.

1. Open SEG_NET_CAL.DBF and INT_NET_CAL.DBF network calibration files from PART_II folder (click on File ➔ specify the .DBF file type and select Open).
2. Scroll to the end of the table and look at the column IF_3Year, PDO_3Year, and TOTAL_3Year. These columns contain aggregated crash counts for 3 year data.
3. Open the PASS tool (Tools ➔ Add ins ➔ PASS) and select Calibrate Models option (Figure 11-27).

![PASS - Main Menu](image)

Figure 11-27 Calibrate Models option from PASS menu

4. Fill the Calibrate Models window as shown in Figure 11-28. Make sure you change the number of years to 3 because you are using crash data for three years.
What we are doing in this step is telling the tool which columns in the segments and intersections network calibration files (`SEG_NET_CAL.DBF` and `INT_NET_CAL.DBF`) contain predictions (Columns with Calculated Crashes) and which columns contain recorded crashes (Columns with Crash Counts) so calibration factors can be developed by comparing both of these columns with adjustment made for the number of years for crash data used (Number of Years for Crash Data).

1. Specify the **Output Directory** leading to `../PART_II/Standard Calibration` folder.
2. Click the **Run** button to generate standard calibration file.

Running this option will generate calibration file (**CAL-FACTORS.DBF**) containing calibration factors developed based on facility classification partitions. Now we can use this calibration file to calibrate default model predictions and calculate calibrated default predictions. Calibration factors contained in the calibration file are applied to the equation by multiplying the default prediction by the appropriate calibration factor. To develop calibrated predictions you have to provide three input files in the **Calculate Crashes** step. The extra input file (as compared to developing default prediction in PART_I) is the developed calibration file (**CAL-FACTORS.DBF**) containing standard calibration factors.

**Calculating crashes with standard calibration factors**

In this example we will append calibrated predictions to the output tables already containing default predictions which were developed by you in PART_I tutorial using **Calculate Crashes** option. Note that as explained earlier this step will have to be executed once for each of the two alternatives. To predict predictions with standard calibration factors for alternative A do the following.

1. Rename outside of TransCAD (right click with mouse and specify **Rename**) the output files for alternative A default crash prediction. These files are provided in the PART_II/alternativeA folder, they are exactly the same files as you have developed in part I. Rename the **INTERSECTION CRASH_DATE.DBF** as **A_INT_DFLT_CRASH.DBF** and rename the **SEGMENT CRASH_DATE.DBF** as **A_SEG_DFLT_CRASH.DBF**. Note that any name which works for you could have been used however for the purpose and clarity of the example these names where used. When using the output of the same module as input in proceeding iteration, files have to be renamed to prevent confusing the PASS tool. Since we will be running the **Calculate Crashes** module second time with inputs being the output of preceding step we have to rename the input files so their name is not the same as the default output file name for this module.
2. Open in TransCAD (File ➔ Open ➔ specify the .DBF extension) the renamed in previous bullet intersection and segments tables \texttt{A\_INT\_DFLT\_CRASH\_A.DBF} and \texttt{A\_SEG\_DFLT\_CRASH\_A.DBF} representing alternative A.

3. Open the PASS tool and click on the Calculate Crashes module. Inside this window input the renamed segment and interaction table (\texttt{A\_INT\_DFLT\_CRASH\_A.DBF} and \texttt{A\_SEG\_DFLT\_CRASH\_A.DBF}) with default predictions and standard calibration factor file (\texttt{CAL-FACTORS.DBF}) just recently developed (Figure 11-29).

![Figure 11-29 Calculating crashes with standard calibration files for alternative A](image)

Running this option will generate two files in \texttt{PART\_II/alternativeA} directory folder: \texttt{INTERSECTION CRASH\_DATE.DBF} (containing standard calibrated intersection predictions appended to intersection table with default predictions for alternative A) and \texttt{SEGMENT CRASH\_DATE.DBF} (containing standard calibrated segment predictions appended to segment table with default predictions for alternative A).

Now to repeat this step for alternative B do the following.

1. Rename outside of TransCAD (right click with mouse and specify Rename) the output files for alternative B default crash prediction. Rename the \texttt{INTERSECTION CRASH\_DATE.DBF} as \texttt{B\_INT\_DFLT\_CRASH.DBF} and rename the \texttt{SEGMENT CRASH\_DATE.DBF} as \texttt{B\_SEG\_DFLT\_...
**CRASH.DBF.** Note that any name which works for you could have been used however for the purpose and clarity of the example these names where used. When using the output of the same module as input in proceeding iteration, files have to be renamed to prevent confusing the PASS tool. Since we will be running the Calculate Crashes module second time with inputs being the output of preceding step we have to rename the input files so their name is not the same as the default output file name for this module. These two files can be found under PART_II/alternativeB directory folder.

2. Open in TransCAD the renamed in previous bullet intersection and segments tables **B_INT_DFLT_CRASH.DBF** and **B_SEG_DFLT_CRASH.DBF** representing alternative B.

3. Open the PASS tool and click on the Calculate Crashes module. Inside this window input the renamed segment, interaction table and calibration file (**B_INT_DFLT_CRASH_A.DBF** and **B_SEG_DFLT_CRASH_A.DBF**) with default predictions and standard calibration factor file (**CAL-FACTORS.DBF**) just recently developed (Figure 11-30).

![Figure 11-30 Calculating crashes with standard calibration file for alternative B](image)

Running this option will generate two files in PART_II/alternativeB directory folder: **INTERSECTION CRASH_DATE.DBF** (containing standard calibrated intersection predictions appended to intersection table with default predictions for alternative B) and
**SEGMENT CRASH_DATE.DBF** (containing standard calibrated segment predictions appended to segment table with default predictions for alternative B). Now we will have calculated standard calibrated predictions for both alternatives. When applying standard calibration in our predictions we are placing emphasis on facility types by making the tool use calibration factors developed for each facility type and severity level. This process increases accuracy of results for the entire network.

**User defined calibration**

Now we will create a new calibration file which will place emphasis on US 27 segments and intersections. To place emphasis on specific regions, corridors, even highway segments or intersections sharing common characteristics, user defined calibration should be applied. User defined calibration introduced additional calibration factors which place emphasis on these added partitions. This is the most accurate calculation method for any partitioned system. In our example we will place emphasis on US27 corridor. Two partitions will be used: **P1SEG** indicating all US 27 segments and **P2INT** indicating all US27 intersections. We will develop a calibration file which will be used in the proceeding step to calculate predictions calibrated with user defined calibration factors using **Calculate Crashes** module. Two additional calibration factors as compared to standard calibration will be added to the developed calibration file, one for US27 segments and one for US27 intersections. Open segments (**SEG_NET_CAL.DBF**) and intersections (**INT_NET_CAL.DBF**) from the **PART_II** folder. These are the same two files you used to develop standard calibration file but this time we will also use the information from the last two columns of these tables which contains US27 partitions for segments and intersections. To run user defined calibration do the following.

1. Open **SEG_NET_CAL.DBF** and **INT_NET_CAL.DBF** network calibration files from **PART_II** folder (**File** ➔ **Open** ➔ remember to specify the .DBF extension).

2. Scroll to the end of both tables notice the P1SEG and P2INT columns.

3. The value in each column indicates if the given field in the table belongs (1) or does not belong (0) to this partition.
4. Open the PASS tool (Tools→Add ins→PASS) and select Calibrate Models option (Figure 11-31).

![PASS - Main Menu](image)

Figure 11-31 Calibrate Models option from PASS menu

5. Fill the Calibrate Models window as shown in Figure 11-32. Make sure you change the number of years to 3 because you are using crash data for three years. This is exactly the same procedure as for standard calibration the only difference is that we are inputting into the tool the extra partitions for US27 segments and intersections under User Defined Partition 1 and User Defined Partition 2.


7. Click the Run button to generate user defined calibration file

Running this option will generate a calibration file (CAL-FACTORS.DBF) containing calibration factors developed based on facility classification partitions and two additional partitions specifying segments and intersections belonging to US 27 corridor. Now we can use this calibration file to calibrate default model predictions and calculate calibrated default predictions.
Calculating crashes with user defined calibration factors

To develop calibrated predictions for user defined calibration is exactly the same as for standard calibration. The only difference is that you have to provide different calibration file (CAL-FACTORS.DBF) in the Calculate Crashes step which contains the extra
calibration factors for added user partitions. To calculate crashes with user defined calibration factors for alternative A do the following.

1. Rename created in previous step for alternative A segments and intersection tables with calibrated standard predictions which can be found in the "PART II/AlternativeA" folder.

2. Rename `INTERSECTION CRASH_DATE.DBF` as `INT__SC_A.DBF` and `SEGMENT CRASH_DATE.DBF` as `SEG_SC_A.DBF`.

3. Open the renamed tables in TransCAD environment.

4. Add two columns to each table by pressing within each table `Dataview ➔ Modify Table ➔ press twice Add fields`. Name the added entries as `P1SEG` and `P2INT`. Confirm with YES. Note you have to do this twice once for segments and once for intersections table. This will append two additional columns.

Now you will have to fill these new columns with binary value specifying if the given field belongs or does not belong to specific user defined partition. This will allow the tool to determine if user defined calibration factor should be applied to calibrate given prediction.

1. Identify segment and intersections belonging to US27.

   In segment table (`SEG_SC_A.DBF`)
   a) Column name `P1SEG`: right click on mouse button; press Fill and select `Formula`. Enter the following condition `H10_LRSID contains "-U-027-"`
   b) Column name `P2INT`: right click on mouse button; press Fill and select with `Single Value` equal to 0

   In intersection table (`INT_SC_A.DBF`)
   c) Column name `P1SEG`: right click on mouse button; press Fill and select with `Single Value` equal to 0
   d) Column name `P2INT`: right click on mouse button; press Fill and select `Formula`. Enter the following condition `(H12LINK contains "-U-027-" or H13LINK contains "-U-027-" or H14LINK contains "-U-027-" or H15LINK contains "-U-027-")"
This will allow the tool to distinguish which segments and intersection belong to US27. Note once again that a value of 1 indicated that a given field belongs to this partition and a value of 0 indicated that a given field does not belong to this partition.

2. Open the PASS tool: Tools→Add Ins→PASS→Calculate Crashes

3. Input the segments (SEG_SC_A) table, intersections table (INT_SC_A.DBF) stored in the PART_II/AlternativeA folder and user defined calibration file (CAL-FACTORS.DBF) stored under PART_II folder directory.

4. Specify the output directory as PART_II/Alternative A

5. Press the Run button

Running this option will generate two files in PART_II/Alternative A directory folder: INTERSECTION CRASH_DATE.DBF (containing user defined calibrated intersection predictions appended to intersection table with standard calibrated and initial predictions for alternative A) and SEGMENT CRASH_DATE.DBF (containing user defined calibrated segment predictions appended to segment table with standard calibrated and initial predictions for alternative A). Now to repeat this step for alternative B we will run everything in the same manner with input specified for alternative B. Note that we are using the same user defined calibration file for both alternatives and if more alternatives where investigated the same file would have been used for all of them. To calculate user defined calibrated predictions do the following.
1. Rename for alternative B segments and intersection tables with default and calibrated standard predictions which can be found in the PART_II/alternativeB. Rename INTERSECTION CRASH_DATE.DBF as INT_SC_B.DBF and SEGMENT CRASH_DATE.DBF as SEG_SC_B.DBF

2. Open the renamed tables in TransCAD environment.

3. Add two columns to each table by pressing within each table Dataview ➔ Modify Table ➔ press twice Add fields. Fill the added entries as P1SEG and P2INT. This is exactly the same procedure as for alternative A. Note that this time you will not have to enter these conditions again since TransCAD stores them for you.

4. Identify segment and intersections belonging to US27.

   In segment table (SEG_SC_B.DBF)
   a) Column name P1SEG: right click on mouse button, fill formula with condition H10_LRSID contains "-U-027-"
   b) Column name P2INT: right click on mouse button; fill with Single Value equal to 0

   In intersection table (INT_SC_B.DBF)
   c) Column name P1SEG: right click on mouse button; fill with Single Value equal to 0
   d) Column name P2INT: right click on mouse button, fill formula with condition (H12LINK contains "-U-027-" or H13LINK contains "-U-027-" or H14LINK contains "-U-027-" or H15LINK contains "-U-027-")

   This will allow the tool to distinguish which segments and intersection belong to US27.

5. Open the PASS tool: Tools ➔ Add Ins ➔ PASS ➔ Calculate Crashes

6. Input the segments (SEG_SC_B) table, intersections table (INT_SC_B.DBF) stored in the PART_II/AlternativeB folder and user defined calibration file (CAL-FACTORS.DBF) stored under PART_II folder directory.

7. Specify the output directory as PART_II/AlternativeB
8. Press the **Run** button

![Image of Calculate Crashes window]

**11-34 Calculating user defined calibrated predictions for alternative B**

Running this option will generate two files in **PART_II/alternativeB** directory folder: **INTERSECTION CRASH_DATE.DBF** (containing user defined calibrated intersection predictions appended to intersection table with standard calibrated and default predictions for alternative B) and **SEGMENT CRASH_DATE.DBF** (containing user defined calibrated segment predictions appended to segment table with standard calibrated and default predictions for alternative B). To display these results follow the same procedure as explained previously.
11.3 PART III Assigning Crashes to Roads

The input files for calibration provided in PART II contain default crash predictions and recorded crashes for three years. Procedure for obtaining default predictions for the network was explained in PART_I. Every time new crash data and/or updated network representation is available user should make use of it and develop new calibration factors to better replicate the actual conditions. This is why it is important to know how to develop calibration network files (which are used to develop calibration factor file) so they can be used in crash prediction, providing more accurate estimates. In this part you will be shown how to assign reported crashes to segments and intersections where they occurred. You will also learn how to read in original crash data as provided from police records and process it using the INPASS tool into 15 different tables. All these tables can be later linked in TransCAD environment if desired, however for the purpose of crash prediction only table type10 which is the collision record will be used. Crashes for two consecutive years will be assigned to the same table to show the process of using the output of previous year crash assignment as input into consecutive year crash assignment.

The starting points of this analysis are six files: segments current network geographic file (HERS HPMS Input), intersections current network geographic file (NODE_CORRECT) with appended corrected facility classification and default predictions, expanded segments table containing default predictions (SEG_CRASH), police crash data file for 2005 (FULL_2005.dat) and type10_2004, type10_2005 geographic crash file (to be found in folder for Part III shown in Figure 11-35). Segments current network is the initial input, intersections current network has been developed in exactly the same manner as intersection tables for alternative A and B in PART_I (notice that we appended correct intersection classification) and expanded segments table containing default predictions has been also obtained in the same manner as expanding and calculating default predictions for alternative A and B in PART_I. In this part they are simply provided as inputs so new features can be explained.
First, the source crash data obtained from state police is read and processed to make them available in the TransCAD environment. To read in crash data you have to run the INPASS tool and specify where the file containing original police crash data is stored. To do this click on **Tools** select **Add Ins** select **INPASS** and click **OK.** This will open INPASS.

**Reading in crashes**

Inside the INPASS Main Menu select Read Crash Data module. This feature allows you to preprocess data into tables compatible with TransCAD environment and segregated into appropriate record type (Figure 11-36).
1. Specify the destination folder of original police crash data file (Input Filename) and the output folder (Output Directory) where you want the preprocessed crash files to be saved. Save this file in the PART_III/Read Crashes folder (Figure 11-37).

2. Press the Read button.

![Read Crash Data window](image)

Running this option will generate 15 comma delimited tables which can be easily opened in TransCAD environment. Type 10 collision record table in addition to being saved as comma delimited text file will also be saved as a database file (type10_YEAR.DBF). This file will be used by us to assign crashes to segments and intersections since it contains the location of crash and severity information. Before assigning crashes to segments and intersections the type10_YEAR.DBF crash file will have to be saved as a geographic file so the tool can create vicinity bands which will determine if the crash lies within specified distance from given facility to be assigned to it. To save the type10_YEAR.DBF crash file as a geographic file do the following.

1. Open the database file from the PART_III/Read Crashes folder by clicking File ➔ Open. Remember to specify the dBASE (.DBF) file type.

2. TransCAD will prompt that it has found coordinate information and if you want to create this file as a geographic file.

3. Select YES and save the file with the same name in the PART_III/Read Crashes folder.
Now we can proceed to assign crashes to segments and intersections. First we will assign crashes for 2004 and then we will use the output of 2004 crash assignment as input for the 2005 crash assignment so crashes for both years will be assigned to the same table. Note that we will be using the provided geographic files not the one just generated since its only a subset of the original data to reduce execution time during training.

Assigning crashes to segments and intersections - first iteration

Open the type10_2004 geographic file in TransCAD environment by clicking File⇒Open and specifying the PART_III folder directory. Remember to change the file type to geographic file. To assign 2004 year recorded crashes to segment and intersection where they occurred we are going to use the Assign Crashes module (Figure 11-38).

![INPASS - Main Menu](image)

**Figure 11-38 Assign Crashes module of INPASS tool**

This module assigns crashes to segments based on band distance specified by the user from the edge of the shoulder. To conventional intersections crashes are assigned based on circular buffers of 250 ft and to interchanges with a circular buffer of 500ft. Assign Crashes module has to be re-run for each year of crash data with modifications made to the input network file name when more than one year crash data is assigned to the same table. In our example we are going to follow this procedure since we are appending two years crash data to the same table. Alternative method is to store each year in a different
folder and join the files to one table after running all year data. Note that Crashes should only be assigned to current network. To assigning crashes for year 2004, do the following.

1. Open in TransCAD environment initial segment table (HERS HPMS Input.DBD) geographic file, expanded segment table with default predictions (SEG_CRASH.DBF), intersection table with correct classification (NODE_CORRECT.DBD) geographic file and type10_2004.DBD collision record geographic file. To open any file press File ➔ Open and specify the correct file type.

2. Change the map layers name for intersection geographic file (NODE_CORRECT). To do this click on NODE_CORRECT.DBD map view then choose Map, select Layers, press Rename and type in INT_Current. Note that any other name different then the map view would work. This prevents the tool from confusion during the crash assignment execution. Notice that this name (INT_Current) will appear as one of the option in the dropdown windows of Assign Crashes module.

3. Input all entries as shown in Figure 11-39. The OSEFC represents column specifying distance from centerline of roadway to shoulder edge.

4. Set the Crashes band at 65 feet. This means for crashes that are further than 65 feet from the edge of any roadway outside shoulder will not be assigned to any segment.

5. Save output to PART_III/2004assigned

Running Assign Crashes option will generate two files, one for segments (ASSIGNEDSEGMENTCRASHES.DBF) and one for intersections (ASSIGNEDNODECRASHES.DBF) with appended crashes for given year. These files will be saved in the specified output folder (PART_III/2004Assinged).

Now to obtain 2005 year crash assignment appended to already assigned 2004 crashes tables we will have to resave the intersection table with appended 2004 recorded crashes as a geographic file (with changed name) and change the name of the segments table with appended 2004 crashes.
Assigning crashes to segments and intersections - multiple iterations

To append 2005 crashes to tables already containing 2004 recorded crashes do the following.

1. Open the intersection table with recorded 2004 crashes (ASSIGNEDNODECRASHES.DBF). TransCAD will ask you if you want to convert the file to a geographic format. Click on YES. Save the file as INT_Assigned04 in the PART_III/2004Assinged folder.

2. Close all tables and views opened in TransCAD environment.

3. Rename the segment table with recorded 2004 crashes outside of TransCAD: rename ASSIGNEDSEGMENTCRASHES.DBF as SEG_Assigned04 (Right click with mouse and press Rename)

5. Change the map layers name for intersection geographic file (INT_Assigned04). To do this click on INT_Assigned04.DBD map view then choose Map, select Layers, press Rename and type in NODE_current. Note that any other name different then the map view (INT_Assigned04) would work.

6. Input all the entries as shown in Figure 11-40.

7. Save output to PART_III/2005Assinged.

Running Assign Crashes option will generate two files, one for segments (ASSIGNEDSEGMENTCRASHES.DBF) and one for intersections (ASSIGNEDNODECRASHES.DBF) with appended crashes for 2005 year. These files will be saved in the specified output folder (PART_III/2005Assinged). Note that the 2005 crashes are appended to segment and intersection tables already containing 2004 crashes. To assign another year crash data to the same table already containing 2004 and 2005 crashes use the same procedure as for assigning 2005 crashes to table already containing 2004 crashes. Developed files are exactly the same as the ones used in PART_II for developing calibration files with the exception that we have assigned two year crash data not three as used in PART_II. Note that you can always use TransCAD standard features to display the results as was done in PART_I for default predictions.
APPENDICES
Appendix A

Variables Transformation during Segment Table Expansion

CRB=1 if $H58\text{ShldT}=6$
CRB=0 otherwise

FC=1 if $H17\text{FC}=2$
FC=0 otherwise

INT\_L=1 if $H88\text{LTurn}\geq 1$ and $H88\text{LTurn}\leq 3$ and ($H89\text{RTurn}<1$ or $H89\text{RTurn}>3$)
INT\_L =0 otherwise

CELT=1 if $H88\text{LTurn}=2$
CELT=0 otherwise

ST\_IMPROVE=1 if $H58\text{ShldT}\geq 2$ and $H58\text{ShldT}\leq 4$
ST\_IMPROVE=0 otherwise

SIG=1 if $H92\text{NSig}>0$
SIG=0 otherwise

\[
AD\text{CURVE} = \frac{1}{3} \cdot (1.7 \cdot H63\text{LCurveA} + 4.45 \cdot H64\text{LCurveB} + 6.95 \cdot H65\text{LCurveC} + \\
\frac{H63\text{LCurveA} + H64\text{LCurveB} + H65\text{LCurveC} + \\
+ 11.2 \cdot H66\text{LCurveD} + 20.95 \cdot H67\text{LCurveE} + 28 \cdot H68\text{LCurveF}}{+ H66\text{LCurveD} + H67\text{LCurveE} + H68\text{LCurveF}})
\]

\[
AG\text{GRADE} = (0.2 \cdot H72\text{LGradeA} + 1.45 \cdot H73\text{LGradeB} + 3.45 \cdot H74\text{LGradeC} + \\
\frac{H72\text{LGradeA} + H73\text{LGradeB} + H74\text{LGradeC} + \\
+ 5.45 \cdot H75\text{LGradeD} + 7.45 \cdot H76\text{LGradeE} + 8.5 \cdot H77\text{LGradeF}}{+ H75\text{LGradeD} + H76\text{LGradeE} + H77\text{LGradeF}})
\]

\[
OS\text{EFC} = \frac{H57\text{MedW}}{2} + \frac{H3\text{4Tlanes}}{2} \cdot H54\text{LaneW} + H59\text{RShldW},
\]

This variable contains the distance from the centerline to the outside shoulder edge which is used in crash assignment.
Appendix B

Model Variables in the Expanded Segment Table

All variables used in the developed models with column names as they appear in the expanded segment table and their definition are shown below.

**Annual average daily traffic (H33AADT)** - An average daily value that represents all days of the reporting year. For two-way facilities, is the AADT for both directions, for one-way streets is the directional AADT. Growth factors must be applied if the AADT is not derived from current year counts. This variable has been coded in units of veh/day.

**Length of section (LENGTH)** - Length of a section measured along the centerline of a roadway. For independently aligned, divided highways, use centerline length as the average of the lengths of the directional roadways, measured along their center lines. This variable has been coded in miles.

**Lane width (H54LANEW)** - For multilane roads is the prevailing width of travel lane on a section rounded to the nearest foot. The width of the travel lane is measured between lane striping. For two-lane roads lane width is the distance from the centerline or delineation to where the pavement/shoulder surface changes, or to the pavement lane striping if the shoulder and pavement surface are the same. Parking lane is excluded from lane width determination for all facility types. Where there is no delineation between the through traffic lane and the shoulder or parking lane, or where there is no centerline, estimate a reasonable split between the actual width used by traffic and the shoulder or parking lane based on State/local design guidelines. This variable has been coded in feet.

**Outside Shoulder width (H59RSHLDW)** - Shoulder width is the width of the shoulder which includes rumble strips and gutter pans and does not include bike lanes and parking lanes. For two lane roads is the predominant width of the shoulder on a section if there is no predominant width enter the average width of both shoulders. For multilane roads is the predominant width of the outside shoulders if there is no predominant width enter the average width of the outside shoulders. Shoulder width should be recorded to the nearest foot. This variable has been coded in feet.

**Inside Shoulder width (H60LSHLDW)** - Inside shoulder width is the predominant width of the inside shoulder which includes rumble strips and gutter pans and does not include bike lanes and parking lanes. If there is no predominant width use the average of both inside shoulders on a given section. Shoulder width should be recorded to the nearest foot. This variable has been coded in feet.

**Median width (H56MEDW)** - predominant width of the median which includes inside shoulders, if any, measured between the inside edges of the through lanes to the nearest foot. If the median width is greater then 100 feet enter 100. Median width does not include turning bays cut into the median. This variable has been coded in feet.

**Access Control (H55ACCESS)** - Measures the degree of access control on sample roadway sections. Enter 1 for full access control (Preference given to through traffic movements by providing interchanges with selected public roads and by prohibiting...
crossing at grade and direct driveway connections), 2 for partial access control (preference given to through traffic movement. In addition to interchanges, there may be some crossings at-grade with public roads, but direct private driveway connections have been minimized through the use of frontage roads or other local access restrictions), 3 for no access control (include all sections that do not meet the criteria above). Control of curb cuts is not access control. If access control is not known enter 1 for interstates, 2 for arterials and 3 for collector and local roads.

**Average degree of curve (ADCURVE)** - expresses the average degree of curve weighted with the length of each curve on that section. It is computed with the following formula:

\[
ADCURVE = \frac{\sum_i S_i \cdot D(a)_i}{\sum_i S_i},
\]

where:

- \(S_i\) = length of horizontal curve \(i\) on section,
- \(D(a)_i\) = degree of curve \(i\) (per 100 ft arc definition).

**Average grade on section (AGRADE)** – is the average absolute grade specified in % on section weighted with the length of each curve on that section. Each grade and flat segment is coded as a separate curve. The sum of all curves equals section length. AGRAD is computed to the following formula:

\[
AGRAD = \frac{\sum_i S_i \cdot G_i}{\sum_i S_i},
\]

where:

- \(S_i\) = length of curve \(i\) on section specified in miles,
- \(G_i\) = absolute grade of curve \(i\) on section specified in %.

**Curb presence (CRB)** – Binary variable indicating the presence of a curb in the vicinity of travel lane for two-lane roadways. For multilane roads this variable indicates presence of outside curb in the vicinity of the travel lane. Enter 1 if curb is present in the direct
vicinity of the travel lane, otherwise enter 0. If a parking lane exists and a curb is present enter 0 for this variable.

**Functional class (FC)** – This binary variable indicates if a given segment is classified as a rural principal arterial. Enter 1 if the section is classified as rural principal arterial, enter 0 otherwise. For any urban facility enter 0.

**Intersection with left turning bay (INT_L)** – Binary variable indicating the presence of intersection with single exclusive left turn lane or multiple turning lanes allowing for simultaneous turns from all turning lanes, through movements are prohibited in these lanes. Enter 1 if section contains intersection with left turning bay(s) only, enter 0 otherwise.

**Continuous left turn lane (CELT)** - Binary variable indicating the presence of a continuous exclusive left turning lane, from intersection to intersection on a given section, through movements are prohibited in this lane. Enter 1 if section contains CLTL, otherwise enter 0.

**Improved shoulder (ST_IMPROVE)** – Binary variable indicating the presence of an improved shoulder on a section. Enter 1 if the section contains an improved shoulder, enter 0 otherwise. Earth shoulder is not considered an improved shoulder but combined shoulder consisting of earth shoulder and paved shoulder is.

**Signal presence (SIG)** - Binary variable indicating the presence of a signalized intersection on a section. Enter 1 if the section contains a signalized intersection, otherwise enter 0.
Appendix C

Model Variables in the Intersection Table

**Major Road Approach Volume (H1AADT)** – Approach volumes on the major links (maximum of two) of the intersection, average daily value that represents all days of the reporting year. This variable should be coded in units of (veh/day).

**Minor Road Approach Volume (H2AADT)** – Approach volumes on the minor links of the intersection, average daily value that represents all days of the reporting year. This variable should be coded in units of (veh/day).

**Surrounding Land Use (H3URBRUR)** - Binary variable indicating whether the intersection is located in a rural or an urbanized area. Enter 1 if the intersection is located in an urban area; enter 0 if the intersection is located in a rural area.

**Paved Shoulder (H4SHOULD)** - Binary variable indicating the presence of a paved shoulder at the side of the major road of the intersection. Enter 1 if a paved shoulder exists, enter 0 otherwise.

**Right-Turn Lane (H5RTMAJ)** - Binary variable indicating the presence of right-turn bay(s) on major roads. Enter 1 if there is a right-turn bay(s) on the major road, otherwise enter 0.

**Left-Turn Lane (H6LTMAJ)** - Binary variable indicating the presence of left-turn bay(s) on at least one approach of major roads. Enter 1 if there is a left-turn bay(s) on at least one approach of major roads, otherwise enter 0.

**Number of Lanes (H7LANE)** - The number of lanes is defined as the total number of approach lanes at an intersection including through, shared and exclusive turning lanes. The number of lanes is determined according to the striping, if present, on multilane facilities, or according to traffic use or State/local design guidelines if no striping is present.

**Median Width (H9MEDWDTH1)** - Variable indicating the median width on major roads measured in feet. It is the predominant width of the median which includes inside shoulders, if any measured between the inside edges of the through lanes to the nearest foot. This variable should be coded in units of feet.

**Three Leg Intersection (H11LEG3)** – Binary variable indicating if a given intersection is a T-intersection. Enter 1 if intersection consists of three legs, otherwise enter 0.

**Signalized Ramp (H12SIG)** – Binary variable indicating presence of signals on a ramp. Enter 1 if the ramp has a signal, otherwise enter 0.
Appendix D
Crash Prediction Models for Indiana

<table>
<thead>
<tr>
<th>Variable description</th>
<th>Column name</th>
<th>IF</th>
<th>PDD</th>
<th>Total</th>
<th>Segment Type Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Segment Length (mi)</td>
<td>LENGTH</td>
<td>0.659</td>
<td>0.601</td>
<td>0.505</td>
<td></td>
</tr>
<tr>
<td>Annual Average Daily Traffic (veh/da)</td>
<td>H33AADT</td>
<td>0.839</td>
<td>0.776</td>
<td>0.773</td>
<td></td>
</tr>
<tr>
<td>Lane Width (ft)</td>
<td>H54LANEW</td>
<td>-0.0773</td>
<td>-0.047</td>
<td>-0.0438</td>
<td></td>
</tr>
<tr>
<td>Outside Shoulder Width (ft)</td>
<td>H59FSLDW</td>
<td>-0.0303</td>
<td>-0.0233</td>
<td>-0.0235</td>
<td>3.68</td>
</tr>
<tr>
<td>Inside Shoulder Width (ft)</td>
<td>H60L3SLDW</td>
<td>-0.299</td>
<td>-0.249</td>
<td>-0.248</td>
<td>0.00612</td>
</tr>
<tr>
<td>Average Degree of Curve (English)</td>
<td>ADCURVE</td>
<td>0.0293</td>
<td>0.0196</td>
<td>0.0211</td>
<td>1.29</td>
</tr>
<tr>
<td>Average Grade on Section (%)</td>
<td>AGRADE</td>
<td>0.0196</td>
<td>0.0205</td>
<td>0.0199</td>
<td>1.61</td>
</tr>
<tr>
<td>Presence of Curb (binary)</td>
<td>CF8</td>
<td>0.318</td>
<td>0.301</td>
<td>0.301</td>
<td>0.00576</td>
</tr>
<tr>
<td>Presence of Signalized Intersection (b)</td>
<td>S16</td>
<td>0.48</td>
<td>0.599</td>
<td>0.502</td>
<td>0.045</td>
</tr>
<tr>
<td>Functional Class (binary)</td>
<td>FC</td>
<td>-0.181</td>
<td>-0.215</td>
<td>-0.211</td>
<td>0.122</td>
</tr>
<tr>
<td>Segment Type 2</td>
<td>Column name</td>
<td>IF</td>
<td>PDO</td>
<td>Total</td>
<td>Segment Type Field</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------</td>
<td>----------</td>
<td>----------</td>
<td>-----------</td>
<td>--------------------</td>
</tr>
<tr>
<td>Rural multilane</td>
<td>Slope</td>
<td>0.00016</td>
<td>0.00327</td>
<td>0.00342</td>
<td>SEG_TYPE</td>
</tr>
<tr>
<td>Variable description</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Segment Length (ft)</td>
<td>LENGTH</td>
<td>0.651</td>
<td>0.552</td>
<td>0.574</td>
<td></td>
</tr>
<tr>
<td>Annual Average Daily Traffic (veh/day)</td>
<td>H33AADT</td>
<td>1.16</td>
<td>0.954</td>
<td>0.968</td>
<td></td>
</tr>
<tr>
<td>Lane Width (ft)</td>
<td>H54LANEW</td>
<td>-0.194</td>
<td>-0.00339</td>
<td>11.9</td>
<td></td>
</tr>
<tr>
<td>Median Width (ft)</td>
<td>H57MEDW</td>
<td>-0.00711</td>
<td>-0.00339</td>
<td>43.2</td>
<td></td>
</tr>
<tr>
<td>Functional Class (binary)</td>
<td>FC</td>
<td>-0.491</td>
<td>-0.28</td>
<td>-0.327</td>
<td>0.517</td>
</tr>
<tr>
<td>Presence of Signalized Intersection (binary)</td>
<td>SIG</td>
<td>0.556</td>
<td>0.63</td>
<td>0.603</td>
<td>0.155</td>
</tr>
<tr>
<td>Presence of Surface Shoulder (binary)</td>
<td>ST_IMPROVE</td>
<td>-0.534</td>
<td>-0.34</td>
<td>0.925</td>
<td></td>
</tr>
<tr>
<td>Available Models</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IntersectionType1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IntersectionType2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IntersectionType3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IntersectionType4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IntersectionType5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IntersectionType6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IntersectionType7</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IntersectionType8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IntersectionType9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Segment Type1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Segment Type2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Segment Type3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Highlighted Model</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Rural multilane</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Models Folder:</td>
<td></td>
<td>C:\Documents and Settings\Michal</td>
<td>Change</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Table Variables

<table>
<thead>
<tr>
<th>Segment Type 4</th>
<th>Segment Type Field</th>
<th>Reference View</th>
<th>View Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Urban twolane</td>
<td>Slope</td>
<td>Segm_Type</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variable Description</th>
<th>Column Name</th>
<th>IF</th>
<th>PDO</th>
<th>Total</th>
<th>Average</th>
</tr>
</thead>
<tbody>
<tr>
<td>Segment Length (mi)</td>
<td>LENGTH</td>
<td>0.427</td>
<td>0.389</td>
<td>0.357</td>
<td></td>
</tr>
<tr>
<td>Annual Average Daily Traffic (veh/day)</td>
<td>HDDAADT</td>
<td>0.729</td>
<td>0.613</td>
<td>0.618</td>
<td></td>
</tr>
<tr>
<td>Access Control (1-full, 2-partial, 3-non)</td>
<td>H55ACCESS</td>
<td>1.59</td>
<td>1.32</td>
<td>1.4</td>
<td>2.99</td>
</tr>
<tr>
<td>Presence of Curb (binary)</td>
<td>CURB</td>
<td>0.364</td>
<td>0.25</td>
<td>0.267</td>
<td>0.00391</td>
</tr>
<tr>
<td>Presence of Intersection with Left Turn</td>
<td>INT_L</td>
<td>0.582</td>
<td>0.172</td>
<td>0.176</td>
<td>0.134</td>
</tr>
<tr>
<td>Presence of Continuous Exclusive Lane</td>
<td>CELT</td>
<td>-0.438</td>
<td></td>
<td></td>
<td>0.121</td>
</tr>
<tr>
<td>Presence of Surface Shoulder (binary)</td>
<td>ST_IMPROVE</td>
<td></td>
<td>-0.312</td>
<td>-0.279</td>
<td>0.581</td>
</tr>
<tr>
<td>Presence of Signalized Intersection (binary)</td>
<td>SIG</td>
<td>0.553</td>
<td>0.645</td>
<td>0.629</td>
<td>0.247</td>
</tr>
<tr>
<td>Inside Shoulder Width (ft)</td>
<td>H60LSHLDW</td>
<td></td>
<td></td>
<td>-0.132</td>
<td>0.0206</td>
</tr>
</tbody>
</table>

Models Folder: C:\Example_study_us27\march07\de
Output Folder: C:\Example_study_us27\march07\de

To save changes permanently for this model, press the "Save" button.
<table>
<thead>
<tr>
<th>Variable Description</th>
<th>Column Name</th>
<th>IF</th>
<th>PDO</th>
<th>Total</th>
<th>Segment Type Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Urban multilane</td>
<td>Slope</td>
<td>0.00467</td>
<td>0.002617</td>
<td>0.003037</td>
<td>SEG_TYPE</td>
</tr>
<tr>
<td>Segment Length (mi)</td>
<td>LENGTH</td>
<td>0.378</td>
<td>0.375</td>
<td>0.369</td>
<td></td>
</tr>
<tr>
<td>Annual Average Daily Traffic (veh/day)</td>
<td>H33AADT</td>
<td>0.863</td>
<td>0.814</td>
<td>0.824</td>
<td></td>
</tr>
<tr>
<td>Access Control (1-full, 2-partial, 3-non)</td>
<td>H55ACCESS</td>
<td>0.301</td>
<td>0.361</td>
<td>0.343</td>
<td></td>
</tr>
<tr>
<td>Median Width (ft)</td>
<td>H57MEDW</td>
<td>-0.00408</td>
<td>-0.00272</td>
<td>-0.00309</td>
<td></td>
</tr>
<tr>
<td>Presence of Continuous Exclusive Left</td>
<td>CELT</td>
<td>0.168</td>
<td>0.128</td>
<td>0.125</td>
<td></td>
</tr>
<tr>
<td>Presence of Surface Shoulder (binary)</td>
<td>ST_IMPROVE</td>
<td>-0.158</td>
<td>-0.347</td>
<td>-0.305</td>
<td></td>
</tr>
<tr>
<td>Presence of Signalized Intersection</td>
<td>SIG</td>
<td>0.499</td>
<td>0.526</td>
<td>0.508</td>
<td>0.415</td>
</tr>
<tr>
<td>Average grade on section (%)</td>
<td>AGRADE</td>
<td>-0.0609</td>
<td>-0.0753</td>
<td>-0.0724</td>
<td>1.08</td>
</tr>
</tbody>
</table>

Available Models:
- IntersectionType3
- IntersectionType4
- IntersectionType5
- IntersectionType6
- IntersectionType7
- IntersectionType8
- IntersectionType9
- SegmentType1
- SegmentType2
- SegmentType3
- SegmentType4
- SegmentType5

Highlighted Model: Urban multilane

To save changes permanently for this model, press the "Save" button.
<table>
<thead>
<tr>
<th>Variable Description</th>
<th>Column Name</th>
<th>IF</th>
<th>PDO</th>
<th>Total</th>
<th>Segment Type Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>One Way Segments</td>
<td>Slope</td>
<td>0.0298</td>
<td>0.028</td>
<td>0.102</td>
<td>SEG_TYPE</td>
</tr>
<tr>
<td>Section Length (mi)</td>
<td>LENGTH</td>
<td>0.444</td>
<td>0.437</td>
<td>0.473</td>
<td></td>
</tr>
<tr>
<td>Annual Average Daily Traffic (veh/da)</td>
<td>H33AADT</td>
<td>0.455</td>
<td>0.637</td>
<td>0.515</td>
<td></td>
</tr>
<tr>
<td>Number of through lanes</td>
<td>H34TLANES</td>
<td>0.425</td>
<td>0.2032</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shoulder Width (ft)</td>
<td>H59RSHLDW</td>
<td>-0.193</td>
<td>-0.269</td>
<td>-0.242</td>
<td></td>
</tr>
<tr>
<td>Average Degree of Curve (English)</td>
<td>ADCURVE</td>
<td>-0.0431</td>
<td>-0.033</td>
<td>-0.0359</td>
<td></td>
</tr>
<tr>
<td>Average grade on section (%)</td>
<td>AGRADE</td>
<td>0.0836</td>
<td>0.0784</td>
<td>0.069</td>
<td></td>
</tr>
</tbody>
</table>

Available Models:
- IntersectionType8
- IntersectionType9
- SegmentType1
- SegmentType2
- SegmentType3
- SegmentType4
- SegmentType5
- SegmentType6
- SegmentType7

Highlighted Model: SegmentType7

To save changes permanently for this model, press the "Save" button.

To load values, press the "Load Values" button.

Models Folder: C:\Example_study_us27_march07\de
Output Folder: C:\Example_study_us27_march07\de

Back | Change | Save | Exit | Next
### Table Variables

<table>
<thead>
<tr>
<th>Variable Description</th>
<th>Column Name</th>
<th>IF</th>
<th>PDO</th>
<th>Total</th>
<th>Intersection Type Field</th>
<th>Reference View</th>
<th>View Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major road approach volume (veh/da)</td>
<td>H1AADT</td>
<td>0.411</td>
<td>0.632</td>
<td>0.551</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Minor road approach volume (veh/da)</td>
<td>H2AADT</td>
<td>0.214</td>
<td>0.132</td>
<td>0.205</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Three leg intersection (binary)</td>
<td>LEG3</td>
<td>-0.548</td>
<td>-0.308</td>
<td>-0.365</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Median width on major road (ft)</td>
<td>H3MEDWDT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Available Models**

- IntersectionType1
- IntersectionType2
- IntersectionType3
- IntersectionType4
- IntersectionType5
- IntersectionType6
- IntersectionType7
- IntersectionType8
- IntersectionType9
- SegmentType1
- SegmentType2
- SegmentType3

**Highlighted Model:**

- TWSC

To save changes permanently for this model, press the "Save" button.
<table>
<thead>
<tr>
<th>Variable Description</th>
<th>Column Name</th>
<th>IF</th>
<th>PDO</th>
<th>Total</th>
<th>Average</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major road approach volume (veh/day)</td>
<td>H1AADT</td>
<td>0.411</td>
<td>0.602</td>
<td>0.551</td>
<td></td>
</tr>
<tr>
<td>Minor road approach volume (veh/day)</td>
<td>H2AADT</td>
<td>0.214</td>
<td>0.132</td>
<td>0.206</td>
<td></td>
</tr>
<tr>
<td>Three leg intersection (binary)</td>
<td>LEG3</td>
<td>-0.548</td>
<td>-0.308</td>
<td>-0.365</td>
<td>0.82</td>
</tr>
<tr>
<td>Median width on major road (R)</td>
<td>H9MEDwDOT</td>
<td></td>
<td></td>
<td>-0.00742</td>
<td>-0.00558</td>
</tr>
</tbody>
</table>

Available Models:
- IntersectionType1
- IntersectionType2
- IntersectionType3
- IntersectionType4
- IntersectionType5
- IntersectionType6
- IntersectionType7
- IntersectionType8
- IntersectionType9
- SegmentType1
- SegmentType2
- SegmentType3

Highlighted Model: TWSC

Models Folder: C:\Documents and Settings\Michal S
Output Folder: C:\output

To save changes permanently for this model, press the "Save" button.
<table>
<thead>
<tr>
<th>Variable description</th>
<th>Column name</th>
<th>IF</th>
<th>PDO</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major road approach volume (veh/da)</td>
<td>H1AADT</td>
<td>0.411</td>
<td>0.602</td>
<td>0.551</td>
</tr>
<tr>
<td>Minor road approach volume (veh/da)</td>
<td>H2AADT</td>
<td>0.214</td>
<td>0.132</td>
<td>0.206</td>
</tr>
<tr>
<td>Three leg intersection (binary)</td>
<td>LEG3</td>
<td>-0.548</td>
<td>-0.308</td>
<td>-0.365</td>
</tr>
<tr>
<td>Median width on major road (R)</td>
<td>H1MEDIWOT</td>
<td>-0.00742</td>
<td>-0.00050</td>
<td>13.0</td>
</tr>
</tbody>
</table>

Available Models:
- IntersectionType1
- IntersectionType2
- IntersectionType3
- IntersectionType4
- IntersectionType5
- IntersectionType6
- IntersectionType7
- IntersectionType8
- IntersectionType9
- SegmentType1
- SegmentType2
- SegmentType3

Highlighted Model: TWSC

To save changes permanently for this model, press the "Save" button.
## Table Variables

<table>
<thead>
<tr>
<th>Variable Description</th>
<th>Column Name</th>
<th>IF</th>
<th>PDO</th>
<th>Total</th>
<th>Intersection Type Field</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major road approach volume (veh/day)</td>
<td>H1AADT</td>
<td>0.574</td>
<td>0.557</td>
<td>0.555</td>
<td></td>
</tr>
<tr>
<td>Minor road approach volume (veh/day)</td>
<td>H2AADT</td>
<td>0.236</td>
<td>0.33</td>
<td>0.307</td>
<td></td>
</tr>
<tr>
<td>Urban location of intersection (binary)</td>
<td>H3URBRUR</td>
<td>0.744</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Width of inside shoulder on major road</td>
<td>H4SHOULD</td>
<td>-0.532</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Width of median on major road (R)</td>
<td>H5MEDWOT</td>
<td>-0.0521</td>
<td>-0.0555</td>
<td>-0.0597</td>
<td></td>
</tr>
</tbody>
</table>

### Available Models
- IntersectionType1
- IntersectionType2
- IntersectionType3
- IntersectionType4
- IntersectionType5
- IntersectionType6
- IntersectionType7
- IntersectionType8
- IntersectionType9
- SegmentType1
- SegmentType2
- SegmentType3

### Highlighted Model:
- Signalized

To save changes permanently for this model, press the "Save" button.
<table>
<thead>
<tr>
<th>Variable description</th>
<th>Column name</th>
<th>Intersection Type Field</th>
<th>Reference View</th>
<th>View Columns</th>
<th>Available Models</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major road approach volume (veh/da)</td>
<td>H1AADT</td>
<td></td>
<td></td>
<td></td>
<td>IntersectionType1</td>
</tr>
<tr>
<td>Minor road approach volume (veh/da)</td>
<td>H2AADT</td>
<td></td>
<td></td>
<td></td>
<td>IntersectionType2</td>
</tr>
<tr>
<td>Urban location of intersection (binary)</td>
<td>H3JRBUR</td>
<td></td>
<td></td>
<td></td>
<td>IntersectionType3</td>
</tr>
<tr>
<td>Right turn bay on major approach (binary)</td>
<td>H5RTMAJ</td>
<td></td>
<td></td>
<td></td>
<td>IntersectionType4</td>
</tr>
<tr>
<td>Left turn bay on major approach (binary)</td>
<td>H6LTMAJ</td>
<td></td>
<td></td>
<td></td>
<td>IntersectionType5</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Variable description</th>
<th>Column name</th>
<th>Intersection Type Field</th>
<th>Reference View</th>
<th>View Columns</th>
<th>Available Models</th>
</tr>
</thead>
<tbody>
<tr>
<td>All way stop controlled</td>
<td>Slope</td>
<td></td>
<td></td>
<td></td>
<td>IntersectionType6</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>IF</th>
<th>PDO</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00131</td>
<td>0.00553</td>
<td>0.00695</td>
</tr>
</tbody>
</table>

Average: 0.65

To save changes permanently for this model, press the "Save" button.
<table>
<thead>
<tr>
<th>Variable Description</th>
<th>Column Name</th>
<th>IF</th>
<th>PDO</th>
<th>Total</th>
<th>Reference View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major road approach volume (veh/da)</td>
<td>H1AADT</td>
<td>0.635</td>
<td>0.659</td>
<td>0.666</td>
<td></td>
</tr>
<tr>
<td>Minor road approach volume (veh/da)</td>
<td>H2AADT</td>
<td>0.499</td>
<td>0.615</td>
<td>0.531</td>
<td></td>
</tr>
<tr>
<td>Urban location of intersection (binary)</td>
<td>H3URBRUR</td>
<td>0.329</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Width of inside shoulder on major road</td>
<td>H4SHOULD</td>
<td>-0.384</td>
<td>-1.52</td>
<td>-1.49</td>
<td>0.968</td>
</tr>
<tr>
<td>Number of approach lanes</td>
<td>H7LANE</td>
<td>-0.144</td>
<td></td>
<td></td>
<td>7.68</td>
</tr>
<tr>
<td>Signal control (binary)</td>
<td>RSIG</td>
<td>0.914</td>
<td></td>
<td></td>
<td>0.086</td>
</tr>
<tr>
<td>Median width on major approach (ft)</td>
<td>H9MEDWOT</td>
<td></td>
<td>0.0159</td>
<td>0.0126</td>
<td>58.8</td>
</tr>
</tbody>
</table>

Available Models:
- IntersectionType1
- IntersectionType2
- IntersectionType3
- IntersectionType4
- IntersectionType5
- IntersectionType6
- IntersectionType7
- IntersectionType8
- IntersectionType9
- SegmentType1
- SegmentType2
- SegmentType3

Highlighted Model:

Models Folder: C:\Documents and Settings\Michal St
Output Folder: C:\output

To save changes permanently for this model, press the "Save" button.
<table>
<thead>
<tr>
<th>Variable description</th>
<th>Column name</th>
<th>IF</th>
<th>PDO</th>
<th>Total</th>
<th>Intersection Type Field</th>
<th>Reference View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Major road approach volume (veh/da)</td>
<td>H1AADT</td>
<td>0.635</td>
<td>0.659</td>
<td>0.666</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Minor road approach volume (veh/da)</td>
<td>H2AADT</td>
<td>0.499</td>
<td>0.615</td>
<td>0.531</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Urban location of intersection (binary)</td>
<td>H3URBRUR</td>
<td>0.329</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Width of inside shoulder on major road</td>
<td>H4SHOULD</td>
<td>-0.304</td>
<td>-1.52</td>
<td>-1.49</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number of approach lanes</td>
<td>H7LANE</td>
<td>-0.144</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Signal control (binary)</td>
<td>RSIG</td>
<td>0.914</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Median width on major approach (ft)</td>
<td>H9MEDWOT</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Available Models:
- IntersectionType1
- IntersectionType2
- IntersectionType3
- IntersectionType4
- IntersectionType5
- IntersectionType6
- IntersectionType7
- IntersectionType8
- IntersectionType9
- SegmentType1
- SegmentType2
- SegmentType3

Highlighted Model: IntersectionType8

Models Folder: C:\Documents and Settings\Michel S\ | Output Folder: C:\output

To save changes permanently for this model, press the "Save" button.
Appendix E

Creating a Partition of the Network with Map View

Any time user wants to select multiple features from the map based on characteristics which are not present or cannot be derived from his network tables he can utilize the TransCAD standard selection features which allow you to select specific features from the current map based on pointing or selecting areas within the map that you want the features to be selected from. This selection method is useful when:

- User wishes to display prediction results for only a portion of his network.
- User wants to develop user defined calibration factor for selected area on a map and calculate crashes with adjustment made for selected region.
- User assigns crashes and wishes to investigate only a specific area of interest.

The above mentioned bullets should not be treated as complete list of all application of this selection method but rather as guidance and pointers on how and where it could be used.

To create a selection based on map features do the following.

- Open in TransCAD (File ➤ Open) environment the geographic file which map view contains the layer from which you will be selecting from.
- Click on the map window
- On the right hand side a toolbox will appear (Figure 11-41)

![TransCAD map toolbox](image-url)
• Select the **Select by Shape** option. This is the most universal selection option available in which you define the selection area shape.

• Drag the selection lines across the map and click the mouse button wherever you want to place a node. Make sure the features you are selecting are entirely within created boundary or they will not be selected. Once you have selected the desired boundary hit the **Enter** key.

• This will close the boundary and put the selected record into a selection set.

• Features you have just chosen will be placed in selection set named **Selection** and highlighted with a color on a map. This is where by default TransCAD placed the selection. You can change this name by using the **Combine Selection** option from the **Selection** tab and copy all records into a new set which name you will specify (Figure 11-42).
If you need to use the selection feature multiple times and then combine all your selections into one big set, you will have to copy the selected items each time from Selection default set to a new set named by you (Figure 11-42) and create a new set at the end containing features from all the renamed smaller sets. Note you can only combine features from two set at a time so you will have to aggregate all the sets in pairs of two and then finally the last two aggregate sets into one big set.

For geographic files created selection sets will also be created in the Dataview and can be accessed there.